






































































































































































































































































































































































































































































Chapter 15 Post processing 

Printing and plotting 

Using the Print View dialog box, you can print a spreadsheet or graphic image of 
your board file to a printer. 

The Screen Plot command spools the screen image to any ofthe Layout-supported 
devices including Gerber, Extended Gerber, Print Manager, and DXF. The purpose 
of thIs command is to create a single plot of the current screen image. Any items that 
are currently visible on the screen appear on the plot; those that are not currently 
visible do not appear on the plot. 

WI See You should use Setup Batch and Run Batch to spool the entire design. For 
information on plotting the whole design, see Running batch post processing in 
this chapter. 

To print a spreadsheet or graphic image of the board 

1 Make the window (design, spreadsheet, or other) active by clicking on the title 
bar. 

2 Zoom in or zoom out to view the desired area to print. 

3 From the File menu in the design window, choose Print. 
or 
Choose the Post Proc. toolbar button, and select Print from the drop list. 

The Print View dialog box display. 

4 To print the image that you see on the screen, choose the OK button to accept 
the default settings. 
or 
To print a scaled image, select the Scaled Plot option, and enter a plotting ratio 
in the Plotting Ratio text box. 

To send the screen image to a plotter 

1 Zoom in or zoom out to view the desired area to plot. 

2 From the File menu in the design window, choose Screen Plot. 
or 
Choose the Post Proc. toolbar button, and select Screen Plot from the drop list. 

The Post Process Setup dialog box displays. 

3 Edit the options as described in Modifying the output in this chapter, and choose 
the OK button. 

Layout plots the image shown on the screen according to the specifications in 
the Post Process Setup dialog box. 
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Generating a drill tape 
When you choose the Drill Tape command, Layout produces drill tape files, 
filename. TAP in Excellon format and places them in the working directory. During 
the manufacturing process, the drilling machine reads these files to determine the 
size and location of the drill holes on the board. 

For a though-hole components, Layout outputs a file, THRUHOLE.TAP. In addition, 
Layout automatically generates drill tape files for each layer pair that shares a blind 
or buried via. For example, for a blind via that runs. from the top layer of the board to 
the third layer of the board, Layout would create a file called 1_3,TAP, for a buried 
via that runs from layer 2 to layer 3, Layout would create a file called 2_3.tap, and so 
on. 

Unless you shift the output in the Post Process Setup dialog box (in the Shift group 
box), the drill tape coordinates match the coordinates that you see in the design 
window. 

Fb Note If you want to keep drill tape files, rename them to avoid replacing them 
with newly generated tapes. 

To generate a drill tape 

1 Choose the Post Proc. button on the toolbar. 

2 From the menu that displays, choose Drill Tape. 

Layout creates drill tape files in Excellon format. 
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Generating reports 
In Layout, you can generate a variety of reports, including part lists, customizable 
component lists, netlists, and rename reports. You choose which reports you want to 
produce in the Generate Reports dialog box. 

To generate reports 

1 Choose the Post Proc. toolbar button. 

2 From the menu that displays, choose Reports. 

The Generate Reports dialog QOx displays. 

3 Select the reports you want to generate by clicking on them with the left mouse 
button. You can deselect selected lines by clicking on them. 

The Generate Reports dialog box 

EI Use defaullfllc names 
[J Append 10 existing reports of same kind 

The reports generated include the following: 

Parts List (Generic) (.PRT) A list of part numbers (derived from the design 
schematic), and part types (also derived from the schematic), followed by a list of all 
components using each combination of part number and part type. The list is 
alphanumerically sorted by part number. Layout assigns the .PRT extension to the 
list file. In the LAYOUT.INI file, this list is referred to as PARTLIST. 

Component Insertion List (.INS) A special version of the user-defined 
Component list predefmed to show component insertion locations. Layout assigns 
the .INS extension to the list file. In the LA YOUT.INI flle, this list is referred to as 
INSTLIST. 

Cross reference list (.CRF) A cross reference list of component pins and the 
net attached to each pin. This list also includes pin locations for testing purposes. 
Layout assigns the .CRF extension to the list flle. In the LAYOUT.INI file, this list is 
referred to as NETLIST2. 
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Net length "list (.NL3) A list of nets with net length information. Layout assigns 
the .NL3 extension to the list file. In the LAYOUT.INI file, this list is referred to as 
NETLIST3. 

Connection List (.CON) A list of point-to-point connections in each net for 
testing point-to-point connectivity. Layout assigns the .CON extension to the list file. 
In the LAYOUT.INI file, this list is referred to as CONNLIST. 

Unused Pins List (.UNU) A list of unused pins on each component. Layout 
assigns the .UNU extension to the list file. In the LAYOUT.INI file, this list is 
referred to as UNUSDLST. 

Rename/Swap List (.REN) A list of all component renames and gate and pin 
swaps, used for documentation purposes and for manual back-annotation for non­
supported schematics. If a back-annotation was performed, this list may appear 
empty. Layout assigns the .REN extension to the list file. In the LAYOUT.INI file, 
this list is referred to as RENAMES. 

TestPoints List (.TSP) A list oftest points and their locations. Layout assigns 
the .TSP extension to the list file. In the LAYOUT.INI file, this list is referred to as 
TPLIST. 

Drill List (.DRL) A human-readable drill list. You can generate the Excellon drill 
tape file by choosing the Post Process tool, then the Drill Tape command. Layout 
assigns the .DRL extension to the list file. In the LA YOUT.INI file, this list is 
referred to as DRILLIST. Blind and buried vias are listed first, broken down by their 
defining layer pair. Then through-hole components are listed. 

Surface Mount Top (.CM1) A list ofSMT components on the top layer of the 
design, along with their associated part numbers, part names and footprints. Layout 
assigns the .CMI extension to the list file. In the LAYOUT.INI file, this list is 
referred to as COMPSTOP. 

Surface Mount Bottom (.CM2) A list ofSMT components on the bottom layer 
of the design, along with their associated part numbers, part names and footprints. 
Layout assigns the .CM2 extension to the list file. In the LAYOUT.INI file, this list 
is referred to as COMPSBOT. 

Through Hole Top (.CM3) A list ofunreflected through-hole components, 
along with their associated part numbers, part names and footprints. Layout assigns 
the .CM3 extension to the list file. In the LAYOUT.INI file, this list is referred to as 
COMPTTOP. 

Through Hole Bottom (.CM4) A list of reflected through-hole components on 
the bottom layer of the design, along with their associated part numbers, part names 
and footprints. Layout assigns the .CM4 extension to the list file. In the 
LAYOUT.INI file, this list is referred to as COMPTBOT. 

R:J Note By definition, through-hole components are not confmed to the top or 
bottom layers; however, they can be rejlected or unrejlected as described by the 
reports Through Hole Top and Through Hole Bottom. 
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Unroute List (.UNR) A list of unconnected tracks in the design. This report also 
lists the X, Y coordinates of each tenninal point in the unconnected routes. Layout 
assigns the .UNR extension to the report file. In the LAYOUT.INI file, this list is 
referred to as UNROULST. 

Padstack List (.THR) A report of all padstacks in the design, along with their 
size and shape, and the footprints and components that employ them. Layout assigns 
the .THR extension to the report file. In the LAYOUT.INI file, this list is referred to 
as THRULIST. 

Drill Layer Pair List (.DRL) A report of all blind and buried vias that exist 
between any two specified layers. The data in this report includes the drill size, drill 
tool, and the X and Y coordinates for the via. For example, 2_5.DRL would report 
data for all vias that exist on or between layers 2 and 5 in the design. Layout assigns 
the .DRL extension to the report file. In the LAYOUT.INI file, this list is referred to 
as DRLA YLST. Through-hole drills have their own file named THRUHOLE.DRL. 

Attribute test listing, comps (.CAT) Sample report that illustrates the use of 
Capture properties in a Layout report. You can use this report as a template for 
creating custom reports that use Capture properties. 

Attribute test listing, nets(.NA T) Sample report that illustrates the use of 
Capture properties in a Layout report. You can use this report as a template for 
creating custom reports that use Capture properties. 

The two user-defmable reports are listed below. 

Component List (Generic) (.CMP) A list of components in alphanumeric 
order, one per line. Infonnation pertaining to each component can be included to the 
right of the component name. Layout assigns the .CMP extension to the list file. In 
the LAYOUT.INI file, this list is referred to as COMPLIST. 

Net List (Generic) (.NET) A list of nets in alphanumeric order, one per line. 
Infonnation pertaining to the net can be included to the right of the net name. Layout 
assigns the .NET extension to the list file. In the LA YOUT.INI file, this list is 
referred to as NETLIST. 

Two kinds of infonnation may be included in a COMPLIST or NETLIST report: a 
FIELD or a ATTR. 

• A FIELD is a Layout design field that can be defined in Layout, and is 
independent of the schematic input (although it may have been originally 
defmed there). 

• An ATTR is a schematic attribute and cannot be defmed or changed in Layout. 

In addition, you can use Layouts report generation capability to back annotate your 
design to your Capture schematic: 

OrCAD Backannotation File This file provides back annotation infonnation 
for your Capture schematic. Layout assigns the .NET extension to the file. To 
complete the back annotation, you need to open Capture on the design and use the 
.SWP file as input to the Gate and Pin Swap tool. 
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Using Layout with other applications 

Part Five explains how to use Layout with orCAD Capture for Windows and with 
third-party printed circuit board applications, such as PADS and CadStar. 

Part Five includes the following chapters: 

Chapter 16: Using Layout with OrCAD Capture for Windows describes how to use 
intertool communication and AutoECO to pass design data between Capture and 
Layout. It describes how to forward annotate schematic netlist data, how to back 
annotate changes from Layout to CaptUre, and how to use cross probing to enhance 
design and board analysis. 

Chapter 17: Importing and exportingfiles describes how to import a design from a 
printed circuit board application other than Layout, place and route the design using 
Layout, then export the board back to the original third-party printed circuit board 
application. 

Part Five. 





Chapter 16 

Using Layout with 
OrCAD Capture for Windows 

Capture and Layout are tightly integrated, providing an easy solution for design 
annotation. Layout has the ability to communicate interactively with OrCAD Capture 
for Windows and other schematic design tools. This chapter explains how to use 
Layout and OrCAD Capture for Windows together to perform annotation and cross 
probing. 

Layout's AutoECO (automatic Engineering Change Order) utility automatically 
forward annotates all schematic attributes, component information, and netlist 
changes to a board from Capture. And, when you make changes to your board, you 
can back annotate the information to your schematic. 

You can also perform cross probing with Capture and Layout. Using cross probing, 
you can select a part, component, or net on a Capture schematic or Layout board, to 
highlight the corresponding object in the other application. 

Moving a design from Capture into Layout is a three-part process: 

• Create a valid Capture design with footprints that Layout supports. 

• Generate a netlist in the Layout format. 

• Create a Layout board file. You can also transmit information concerning nets 
and parts by creating specially-named properties on the nets or parts. 

WI See Layout also accepts netlist (.MNL) files from other vendor's software. For 
information on netlist translation, see Chapter 17: Importing and exporting files. 
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Preparing your Capture design for use with Layout 
To prepare a Capture design for Layout you must first create the schematic design, 
assigning special properties and Layout-supported footprints. The tables in this 
section list the properties and footprints supported by Layout. 

To prepare your Capture design for use with Layout 

1 Create a schematic design using Capture. In order to have the ability to use 
intertool communication successfully between Capture and Layout, you will 
need to annotate, check design rules, and create a netlist in physical view. 
Normally, this is only necessary for complex hierarchical designs. However, 
even if you are creating a simplified hierarchy or flat design, you must choose 
Physical from the View menu before annotating the design. 

m See For information about creating a design in Capture, see the DrCAD Capture 
for Windows User's Guide and online help. 

2 To transfer part or net information from the schematic to the board, add a user­
defined property with a name from the property tables below, and assign a value 
to the property. The property name must be in uppercase, as shown in the tables. 

Property name 

FPLlST 

COMPLOC 

COMPROT 

COMPGROUP 

COMPKEY 

COMPF/XED 

COMPS/DE 

COMPLOCKED 

Description 

Comma-delimited list of alternate footprints. 

Part location on the board as X and Y coordinates. 
Use the following format: [X y] where X and Y 
represent the coordinates. Both must be integers in mils 
or microns. 

Part rotation in degrees and minutes from the 
orientation defined in the Layout library. Use a period 
(.) to separate degrees and minutes. 

An integer value that assigns the part to a group for 
placement. 

The value "YES" assigns the highest priority for 
autoplacement within the group. 

Ifvalue is "YES," the part (such as an edge connector) 
is permanently fixed to the board. 

Determine the side of the board that the components are 
mounted on. 

Ifvalue is "YES," the part is temporarily locked in 
position. 

User-defined part properties that can be transferred to Layout. 
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Property name 

ROUTELAYERS 

PLANELAYERS 

NETWEIGHT 

VIAPERNET 

WIDTH 

CONNWIDTH 

MIN WID TH 

MAXWIDTH 

WID THB YLA YER 

SPACINGBYLA YER 

RECONNTYPE 

TESTPOINT 

HIGHLIGHT 

Chapter 16 Using Layout with DrCAD Capture for Windows 

Description 

Comma-delimited list assigning net to specific layers. 

Comma-delimited list assigning net to specific plane 
layers. 

Integer between 1 and 100 assigning relative priority to 
the net; default value is 50. 

Via types allowed for net. 

Value is assigned to the MINWIDTH, MAXWIDTH 
and CONNWIDTH properties unless overridden. 

Sets the track width. 

Sets the minimum track width. 

Sets the maximum track width. 

Net width for one or more layers, for example 
TOP==6 I BOT==12. 

Net spacing for one or more layers, for example 
TOP==13 I BOT==8. 

Specifies the reconnect rules for each type of reconnect. 
Values may be STD, HORZ, VERT, MIN, or ECL. 

Ifvalue is "YES," test point is automatically assigned to 
the net. 

If value is "YES," net is highlighted. 

User-defined net properties that can be transferted to Layout. 

3 Assign PCB footprints to each of your schematic parts. Use only Layout­
compatible footprints, choosing from those shown in the OrCAD Layout for 
Windows Footprint Libraries document, or those in your custom footprint 
libraries. 

4 If you are using parts from non-Layout libraries, such as discrete parts and 
custom footprints, check that the pin numbers of your schematic part match the 
pad numbers of your Layout footprint. You may need to work with Capture's 
part editor or Layout's footprint libraries. In addition, you need to make sure that 
each pin in the Capture schematic has a pin number, as well as a pin name. 

Fb Note Layout doesn't accept PCB footprint names or part values that include 
spaces or tabs. Use the Capture spreadsheet editor to eliminate space or tab 
characters in the property values. 

5 Choose Physical from the View menu, then use Capture's Design Rules Check 
tool to check for design rule violations. 
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Creating a net list in OrCAD Capture for Windows 
After you have prepared your design in Capture, and it is free from design rule 
violations, you are ready to create a netlist (.MNL) file for use with Layout. A 
LAYOUT.INI file must exist in the Windows directory for Capture to generate a 
netlist. 

~ Tip You must save your Capture design before creating a netlist. 

To create a .MNL net list for use in Layout 

1 Open the Capture for Windows schematic design. 

2 Choose Physical from the View menu. 

3 In Capture, choose Create Netlist fi:om the Tools menu. 

The Create Netlist dialog box displays. 

4 In the Create Netlist dialog box, choose the Layout tab. 

5 In the PCB Footprint group box, accept the default {PCB FOOTPRINT} in the 
Combined Property String text box. 

m See For information about combined property strings, see Capture's online help. 

6 Ensure that the full path to the netlist file appears in the Netlist File text box. 
The netlist assumes the name of the Capture design file, but adds a .MNL 
extension. 

7 In the Options group box, select the Run ECO to Layout option. 

~ Tip Select the Run ECO to Layout option in Capture (in the Create Netlist dialog 
box) to automatically communicate schematic modifications to Layout. If the 
board file is open when you update the netlist file, Layout automatically displays a 
dialog box asking if you want to load the new netlist file. If the board file is not 
open when the netlist changes, Layout prompts you to load the modified netlist 
when you reopen the board file. 

8 Choose the OK button to process the netlist. 

Capture creates the .MNL file and saves it in the directory you specified. 

Fb Note If Capture is unable to create an .MNL file, the errors are written to the 
Capture session log and to the .ERR file in the target directory for the .MNL file. 

Fb Note You may choose to exit Capture at this time. It is not necessary to run 
Capture and Layout simultaneously to take advantage of forward annotation; you 
must have a minimum of 16 MB of RAM to run Capture and Layout at the same 
time. 
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AutoECO selectively communicates infonnation from Capture to Layout, or from 
one printed circuit board to another. 

When bringing data into Layout from Capture, you can choose the appropriate 
AutoECO option to annotate only the schematic data that has changed. This way, 
you can avoid inadvertently overriding board data that you do not want to change. 

You can also choose from two AutoECO options that communicate infonnation 
between printed circuit boards. 

To choose an AutoECO option 

.... From the Tools menu in the Layout session frame, choose one of the flavors of 
AutoECO as described in this section. 

The AutoECO options are listed below. The fIrst four options transfer data from 
Capture to Layout during forward annotation. The last two (AutoECOIDXF and 
AutoECOlNet Attrs) communicate infonnation between printed circuit boards. 

AutoECO This option adds and deletes components and nets, but does not 
override board attributes. This version is executed when Layout runs AutoECO 
automatically. 

AutoECOIOverride This option creates a new board or merges new components 
and connections with an existing board. It overrides all of the attributes in an existing 
board. 

AutoECO/Add Only Add components and nets, but do not override the board 
attributes. 

AutoECOI Add Override Add components and nets and update component and 
net properties. 

AutoECO/OXF This option transfers obstacles and text from one board to 
another. 

AutoECO/Net Attrs This option transfers net attributes such as width, weight, 
spacing per layer, width per layer, and reconnection type from one board to another. 
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The following table summarizes the capabilities of each type of AutoECO that 
communicates data from Capture to Layout (.MNL to .MAX) during forward 
annotation: 

AutoECO Override Add Only Add Override 

Components Match Match Match schematic Match schematic 
schematic schematic except deletes except deletes 

Nets Match Match Match schematic Match schematic 
schematic schematic except deletes except deletes 

Obstacles No changes No changes No changes No changes 

Text No changes No changes No changes No changes 

Placement No changes Match No changes Match schematic 
except new schematic except new except deletes 

Component No changes Match No changes Match schematic 
Properties except new schematic except new except deletes 

Net No changes Match No changes Match schematic 
Properties except new schematic except new except deletes 

The following table summarizes the capabilities of each type of AutoECO that 
communicates data between printed circuit boards during translation: 

DXF Net Attrs 

Components No changes No changes 

Nets No changes No changes 

Obstacles Add/replace No changes 
from new board 

Text Add/replace No changes 
from new board 

Placement No changes No changes 

Component No changes No changes 
Properties 

Net No changes Match original 
Properties board where 

20ssible 
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Match schematic All existing data on the PCB in this category is made to match 
the schematic, including additions and deletions. 

Match schematic except deletes All existing data on the PCB in this category 
is made to match the schematic, including additions, but not deletions. 

No changes except new All existing data on the PCB in this category remains 
the same, except additions are made from the schematic. 

No changes All data in this category in PCB remains the same. 

Add/replace from new board Any matches to existing data on the old PCB are 
replaced from new PCB design, including additions, but not deletions. 

Match original board where possible Any matches to existing data on the 
old PCB are replaced from new PCB design, but no additions or deletions are made. 
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Forward annotating Capture schematic data into Layout 
This section demonstrates how to bring netlist data into a board design from 
OrCAO's Capture for Windows. 

You can bring Capture netlist infonnation into Layout in two ways. You can choose 
one of the AutoECO . options to merge the netlist with the board file, or you can select 
the Run ECO to Layout option in Capture (in the Create Netlist dialog box) to 
automatically communicate schematic modifications to Layout. If the board file is 
open when you update the netlist file, Layout automatically displays a dialog box 
asking if you want to load the new netlist file. If the board file is not open when the 
netlist changes, Layout prompts you to load the modified netlist when you reopen the 
board file. . 

Fb Note LAYOUT.INI must exist in the WINDOWS directory in order for Capture 
to perform a forward annotation to Layout. 

To forward annotate schematic data Into Layout from Capture 

1 From the Tools menu in the session frame, choose ECOs and one of the 
AutoECO options as described in Using AutoECO in this chapter. 

The File A (original components and nets) dialog box displays. 

2 Select the original board file (.MAX) to which you want to add the new 
schematic information and choose the Open button. 

The File B (new components and nets) dialog box displays. 

3 ' Locate and select the netlist (.MNL) that you updated and choose the Open 
button. 

The Output report dialog box displays. 

4 Enter a name for the output report (usually design_name.LIS), and select a target 
location. Choose the Save button. 

The output report opens in a text editor and the Merged Output Binary dialog 
box displays. 
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5 Name the file and select a target location. 

Layout merges the files based on the type of AutoECO you have chosen. 

W See If AutoECO fmds errors, it displays an .ERR file with explanations of the 
errors. To correct pin problems, you may return to Capture and change pin 
numbering, then repeat this entire procedure. If Layout is unable to find a 
designated footprint, a dialog box allowing you to link footprints with components 
displays. For information on using this dialog box, see Resolving AutoECD errors 
in Chapter 3: Getting started. 

Fb Note If part and net information does not appear in the Layout design, check 
that the property names are uppercase and identical to those in the part and net 
property tables in this chapter, and that the LA YOVT.INI file is in the directory in 
which Windows is installed. 

Or, if the Run ECO to Layout option is enabled in Capture 

1 In the design manager, choose Open and Board from the File menu. 

The Load Board dialog box displays. 

2 Select the board design that you want to open and choose the OK button. 

Layout tells you that the schematic netlist for the board file has changed and 
asks if you want to load the updated file. 

3 Choose the Yes button to load the updated netlist. 
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Back annotating board information to Capture from Layout 
In Layout, you can back annotate board changes automatically to orCAD Capture 
for Windows using the orCAD Backannotation File (.SWP). 

Or, to back annotate to a schematic capture application other than Layout, you can 
generate a file called Rename/Swap, and use it as a reference to update your 
schematic manually. 

To back annotate your Capture schematic 

1 Choose the Post Proc. toolbar button. 

2 Choose Reports from the drop list. 

The Generate Reports dialog box displays. 

3 If you have reannotated the names of parts, select orCAD Backannotation File 
(.SWP), then choose the OK button. 

Fb Note Once the .SWP file is created, the current Layout design file no longer 
contains the .SWP information. A copy of the design is saved as ' 
BACKANNO.MAX. This file contains all of the swap information. 

4 If it is not already open, start orCAD Capture for Windows and open your 
schematic. 

5 From Capture's View menu, choose Physical. 

6 From Capture's Tools menu, choose Gate and Pin Swap. 

7 In the dialog box that displays, choose the Browse button. 

S Locate and select the report you created in Layout, design_name.SWP which 
should be in the same directory as your design. Choose the OK button. 

The Layout design information is back annotated to the ,schematic in Capture 
automatically. 

To back annotate to your non-Capture schematic 

1 Choose the Post Proc. toolbar button. 

2 Choose Reports from the drop list. The Generate Reports dialog box displays. 

3 Select Rename/Swap List (.REN), then choose the OK button. 

4 Use the file manually to update your schematic. 
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Using cross probing 
Using cross probing, you can select an object in Layout or Capture, and have the 
corresponding object highlighted in the other application. For example, you can 
select a net on your schematic and see the corresponding net highlighted in Layout. 

Fb Note It is necessary to run Capture and Layout simultaneously to use cross 
probing. You must have a minimum of 16 MB of RAM to run Capture and Layout 
at the same time . 

. Enabling ITC between Capture and Layout 
To use cross probing, you must open the same design in Layout as in Capture. In 
Capture you must be in physical view, and you must enable ITC. It is not necessary 
to enable ITC in Layout, as cross probing is always active in Layout. 

! Tip You can use Layout's Half Screen command (available from the Window 
menu) to tile the Capture and Layout windows so that you can view both on your 
screen. 

To enable ITC in Capture 

1 From Capture's Options menu, choose Preferences. 

Capture displays the Preferences dialog box. 

2 Choose the Miscellaneous tab. 

3 Select Enable intertool communication, then choose the OK button. 
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Cross probing from Capture to Layout 
When ITC is enabled in Capture and you select certain items on your schematic 
page, cross probing highlights the corresponding components in Layout. If you select 
a part or gate in a multipart package in Capture, cross probing highlights the 
corresponding module in Layout. If you select a wire segment or net in Capture, 
cross probing highlights the corresponding net (in its entirety) in Layout. 

Fb Note Capture must be in physical view when cross probing. 

Any action you perform to select an object on your Capture schematic (selecting 
using the mouse, using the Find command, or by performing a browse of parts) 
causes the corresponding object in Layout to be highlighted. For more information, 
see the following table. 

Selecting this in Capture Highlights this in Layout 

Part Corresponding module 

Gate (multiple parts per package) Corresponding module 

Wire segment Entire net 

Net All routes for the net 

Pin on part Corresponding module 

Fb Note When you use block selection in Capture, cross probing only highlights the 
last item selected in the block. There is no way to predict the order in which items 
are selected in a block selection. . 

To select an object in Capture for cross probing with Layout 

1 Open a Capture schematic and a matching Layout design. 

2 Choose Half Screen from the Layout Window menu and resize the application 
windows to view the Capture schematic and Layout board side-by-side. 

3 In Capture, choose Physical from the view menu. 

4 Also in Capture, choose Preferences from the Options menu. Choose the 
Miscellaneous tab, select Enable intertool communication, and choose the OK 
button. 

S Select an object in Capture. 

The corresponding object is highlighted on the board in Layout. 
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Cross probing from Layout to Capture 
When ITC is enabled in Capture, selecting objects in Layout causes Capture to 
highlight the corresponding modules in the schematic page editor. Selecting a 
module (or a module pad) causes Capture to highlight all the schematic parts 
included in that module. Selecting a track or net causes Capture to highlight the 
corresponding schematic net on the open page. 

Any action you perform to select an object on your Layout board (selecting using the 
mouse, using query, or using the Find command) causes the corresponding object on 
the Capture schematic to be highlighted. For more infonnation, see the following 
table. 

Selecting this in Layout 

Module 

Track 

Net 

Pad on module 

Highlights this in Capture 

All parts in the package 

Corresponding wire connection 

Corresponding nets 

Corresponding part (If the Manual 
Route tool is selected in Layout, the net 
is highlighted) 

To select an object in Layout for cross probing with Capture 

1 Open a Capture schematic and a matching Layout design. 

2 Choose Half Screen from the Layout Window menu and resize the application 
windows to view the Capture schematic and Layout board side-by-side. 

3 In Capture, choose Physical from the view menu. 

4 Also in Capture, choose Preferences from the Options menu. Choose the 
Miscellaneous tab, select Enable intertool communication, and choose the OK 
button. 

S Select an object in Layout. 

The corresponding object is highlighted on the schematic in Capture. 

Fb Note In Capture, the schematic automatically opens and displays the schematic 
page on which the corresponding symbol is located. Scroll the window until the 
highlighted symbol is visible. 
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Importing and exporting files 

Layout uses powerful translation tools to provide an easy solution for easy board and 
netlist translation. 

In the Layout session frame, the Import option on the File menu provides access to 
netlist and printed circuit board translators that convert your schematic netlist or PCB 
into Layout format. The Export menu contains PCB translation programs for use 
with Layout when you are using it as a placement and routing tool. 

Using the Import and Export translators, you can import a design from a printed 
circuit board application other than Layout, place and route the design using Layout, 
then export the board back to its original printed circuit board application. For 
example, a board created in PADS can be imported into Layout for placing and 
routing, then exported back to PADS. 

You cannot import a board created in one application, such as PCAD, place and 
route it using Layout, then export it to an application other than PCAD-the import 
application must be the same as the export application. 

Layout supports the following netlist formats: 

• MAX ASCII netlist 

• OrCAD PCB II netlist 

• Futurenet netlist 

• PCAD netlist 

Layout supports the following printed circuit board formats: 

• MAX Interchange (.MIN) board files 

• OrCAD PCB 386+ board files 

• CadStar printed circuit board 

• PADS printed circuit board 

• PCAD printed circuit board 

• Protei printed circuit board 

• Tango printed circuit l:>oard 

• DXF board file 
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Netlist translators 

MAX ASCII files 
If you have a schematic capture program that creates an ASCII netlist file in the 
Layout format, you can import the file into Layout to create a new design. You can 
also create the ASCII netlist using a text editor. 

To export a Layout netlist file (.MNL) to ASCII 

1 Open the Layout session frame. 

2 Choose Export from the File menu, and then choose MNL to MAX ASCII 
(.ASC). The MAX Netlist Biruiry Input dialog box displays. 

3 Find and select the .MNL file you want to export to ASCII, then choose the 
Open button. The MAX ASCII dialog box displays. . 

4 Enter the filename and directory of the new ASCII file, then choose the Save 
button. Layout exports the .MNL file to ASCII. 

To import an ASCII file as a Layout netlist file 

1 Open the Layout session frame. 

2 Choose Import from the File menu, then choose MAX ASCII to MNL. The 
MAX ASCII dialog box displays. 

3 Find and select the ASCII file (.ASC) file you want to import to Layout, then 
choose the Open button. The MAX Netlist dialog box displays. 

4 Enter the filename and directory of the new .MNL file, then choose the Save 
button. Layout creates the .MNL file. 
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MAX ASCII file format 
You can create an ASCII netlist file (.ASC) from scratch and import it into Layout as 
a Layout netlist file (.MNL). The format for such files is shown below. 

General format 

MAX ASCII files use the following general format: 

*MAX 

*USER user-param 

*INCH inch-param 

*METRIC metric-param 

* START 

File data 

Package and Symbol data 

Component data 

Net data 

*END 

User-param 

Specifies the number of base units or microns equal to one user unit. The default 
value for this parameter is 60 (one user unit unit=60). 

Inch-param 

Specifies the default granularity of the design, and is the base unit size used by the 
METRIC.TCH file. The default value for this parameter is 
0.00001666666666666667. 

Metric-param 

Specifies use of metric units. If set to YES, Layout uses metric units. The default 
value for this parameter is NO. 
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File data format 

File data provides infonnation al;>out the design file. These lines are not required. 
Layout generates these lines when you export an .MNL file to ASCII. File data uses 
the standard attribute data fonnat. 

Package and Symbol data 

Package data provides pin infonnation for each device. Symbol data match footprint 
pins with pins that appear in the netlist and pins that appear in the package. 

Component data 

Component data provides component infonnation. One component is specified in a 
single line, with optional attribute lines immediately after. 

Net data 

Net data provides net infonnation. A single net is specified on one or two lines, with 
optional attribute lines immediately after. 
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The following is an example of a Layout ASCII netlist file (.ASC): 

*MAX*USER 60 

*INCH 0.00001666666666666667 

*METRIC NO*START*ATTRKey="SourceFile" "Count" 100 "Count" 1 
"C:\ORCADWIN\CAPTURE\DESIGN\SDNIG_B-O 1.DSN" 813922584 

* ATTR Key="SourceModeAttr" "Count" 1 00 "Count" 0 
"C:\ORCADWIN\CAPTURE\DESIGN\SDNIG_B-01.DSN" 1 *PACKAGE 1 
"74LSOO" 

1 "A" "10" 1 0 LOAD 

2 "A" "11" 1 0 LOAD 

3 "A" "0" 1 0 SOURCE 

4 "B" "10" I 0 LOAD 

5 "B" "11" 1 0 LOAD 

6 "B" "0" 1 0 SOURCE 

7 "C" "10" 1 0 LOAD 

8 "C" "11" 1 0 LOAD 

9 "C" "0" 1 0 SOURCE 

1 0 "D" "10" 1 0 LOAD 

11 "D" "11" 1 0 LOAD 

12 "D" "0" 1 0 SOURCE*SYMBOL 1 "74LSOO" 

"1" 

2 "2" 

3 "3" 

4 "4" 

5 "5" 

6 "6" 

7 "9" 

8 "10" 

9 "8" 

10 "12" 

11 "l3" 

12 "11 "*PACKAGE 2 "C:\QRCADWIN\CAPTURE\DESIGN\SDT\FIG_B­
o 1.0LB17 4LSOO" 

1 "A" "10" 1 0 LOAD 
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2 "A" "II" 1 o LOAD 

3 "A" "0" 1 0 SOURCE 

4 "B" "10" 1 0 LOAD 

5 "B" "II" 1 0 LOAD 

6 "B" "0" 1 0 SOURCE 

7 "C" "10" 1 0 LOAD 

8 "C" "II" 1 0 LOAD 

9 "C" "0" 1 0 SOURCE 

10 "D" "10" 1 0 LOAD 

11 "D" "II" 1 0 LOAD 

12 "D" "0" 1 0 SOURCE*SYMBOL 2 
"C:\ORCADWIN\CAPTURE\DESIGN\SD1iFIG_B-Ol.0LBI74LSOO" 

1 "1" 

2 "2" 

3 "3" 

4 "411 

5 "5" 

6 "6" 

7 "9" 

8 "10" 

9 "8" 

10 "12" 

11 "13" 

12 "11 "*PACKAGE 3 "74LS32" 

"A" "10" 1 0 LOAD 

2 "A" "II" 1 o LOAD 

3 "A" "0" 1 0 SOURCE 

4 "B" "10" 1 0 LOAD 

5 "B" "II" 1 0 LOAD 

6 "B" "0" 1 0 SOURCE 

7 "C" "10" 1 0 LOAD 

8 "C" "11" 1 0 LOAD 

9 "C" "0" 1 0 SOURCE 

242 DrCAD Layout for Windows User's Guide 



Chapter 17 Importing and exporting files 

10 "D" "10" I 0 LOAD 

11 "D" "11" I 0 LOAD 

12 "D" "0" I 0 SOURCE*SYMBOL 3 "74LS32" 

111" 

2 "2" 

3 "3" 

4 "4" 

5 "5" 

6 n61~ 

7 119" 

8 "10" 

9 118" 

10 "12" 

11 "13" 

12 "II "*COMP U1 "74LSOO" Footprint="PIPI4" MFootprint="" Package=1 

*ATTRKey="GateUIDAttr" "Comp" I "IoErr" 1 "" 21 

* ATTR Key="GateUIDAttr" "Comp" I "IoErr" 2 "" 27*COMP U2 "74LS32" 
Footprint="DIPI4" MFootprint="" Package=3*NET "OUT" NETLEV:65535 

*NET "OUT" U2."3"*NET "B" NETLEV:65535 

*NET "B" Ul."4"*NET "N00040" NETLEV:65535 

*NET "N00040" U2."I" Ul."8"*NET "A" NETLEV:65535 

*NET "A" Ul."9" Ul."IO"*NET "Q" NETLEV:65535 

*NET "Q" Ul."I" Ul."6" U2."2"*NET "vcc" NETLEV:65535 

*NET "vce" Ul."14" Ul."14" U2."14" Ul."14"*NET "GND" NETLEV:65535 

*NET "GND" Ul."7" Ul."7" U2."7" Ul."7"*NET "N00036" NETLEV:65535 

*NET "N00036" Ul."3" Ul."5"*NET "CLOCK" NETLEV:65535 

*NET "CLOCK" Ul."2"*END 
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PCB /I Netlist 
The PCB II netlist command translates a PCB II netlist file (.NET) into a Layout 
netlist file (.MNL). 

To translate a PCB II netlist into a Layout net list 

1 In the Layout session frame, choose Import and PCB II Netlist from the File 
menu. 

2 In the orCAD netlist input file dialog box, select a PCB II netlist file (.NET) and 
choose the Open button. 

3 In the MAX Netlist Output dialog box, enter a name for the Layout netlist with a 
.MNL extension and choose the Save button. 
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The Futurenet Netlist command translates a Futurenet netlist file (.NET) into a 
Layout netlist file (.MNL). 

To translate a Futurenet netlist into a Layout netlist 

1 In the Layout session frame, choose Import and Futurenet Netlist from the File 
menu. 

2 In the Futurenet input file dialog box, select a Futurenet netlist file (.NET) and 
choose the Open button. 

3 In the MAX Netlist dialog box, enter a name for the Layout netlist with a.MNL 
extension and choose the Save button. 

4 When the dialog box appears displaying the message "Processing completed," 
choose the OK button to dismiss it. 
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PCAD Netlist . 
The PCAD Netlist command translates a PCAD netlist file (.PDF) into a Layout 
netlist file (.MNL). 

To translate a PCAD net list into a Layout netlist 

1 In the Layout session frame, choose Import and PCAD Netlist from the File 
menu. 

2 In the PCAD PDIF dialog box, select a PCAD netlist file (.PDF) and choose the 
Open button. 

3 In the MAX Netlist dialog box, enter a name for the Layout netlist with a .MNL 
extension and choose the Save button. 

4 When the dialog box appears displaying the message "Processing completed," 
choose the OK button to dismiss it. 
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Board translators 

Layer mapping 

Layout translators support several printed circuit board fonnats including PCB 386+, 
Futurenet, PADS, PCAD, ProteI, and Tango. The Import and Export commands are 
available on the File menu in the session frame. When using third-party CAD tools, 
you must also ensure that the layers map properly from one application to another. 

When translating boards between applications, you should make sure that the layers 
are mapped properly in the LA YOUT.INI file. The layer mapping assignments are 
kept in the LAYOUT.INI file, and are user-editable. LA YOUT.INI should be located 
in the WINDOWS directory. However, use caution when editing the LAYOUT.INI 
file. If you vary from the correct syntax or layer nicknames, you may have 
unpredictable results. There is no error checking for layer mapping, so you should 
check your board afterward, to make sure the layers mapped correctly. 

There are mapping strategies for each CAD tool already in place in the 
LA YOUT.INI file. The strategies are based on the default layer structure specific for 
each tool. P-CAD, Protei, and Tango users will probably need only one copy of 
LAYOUT.INI, because the layers on those systems are named, and usually have a 
one-to-one correspondence to similar layer names in Layout. For instance, the TOP 
layer in Layout is usually named COMP in P-CAD, and TOP in Protei and Tango. 
The INNERI and INNER2 layers in Layout are named INTI and INT2 in P-CAO, 
and MIDI and MID2 in Protei and Tango. The BOTTOM layer in Layout is usually 
named SOLDER in P-CAD, and BOT in ProteI and Tango. 

CadStar and PADS users will probably needmore than one copy ofLAYOUT.INI, 
because the layers are numbered, and sometimes mean something different in every 
job. The TOP layer in Layout is usually LAYERl in both CADSTAR and PADS, 
and the BOTTOM layer in Layout is usually LA YERl6 in CADST AR. However, the 
BOTTOM layer in Layout might be LA YER2, LA YER4, LA YER6, or LA YER8 in 
PADS, depending on the number of routing layers on the PADS board. 

You do not have to be cqncemed about mapping the documentation layers in Layout, 
other than for reference, if you want to see the component outlines. However, you 
need to bear in mind that the documentation layers might also be on different 
numbered layers on different jobs, so you should adjust the LA YOUT.INI for these 
jobs accordingly. 
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Each layer mapping section within the LAYOUT.INI file is used as follows: 

[PCADXMAPPING] Matches P-CAD layer names to Layout layer names. Used 
during import of a P-CAD design to Layout. 

[PCADBMAPPING] Matches Layout layer names to P-CAD layer names. Used 
during export ofa Layout design to P-CAD. 

[TANGOXMAPPING] Matches Tango layer names to Layout layer names. Used 
dUring import of a Tango design to Layout. 

[TANGOBMAPPING] Matches Layout layer names to Tango layer names. Used 
during export of a Layout design to Tango. 

[CADSTARXMAPPING] Matches CADSTAR layer numbers to Layout layer 
names. Used during import ofa CADSTAR design to Layout. 

[CADSTARBMAPPING] Matches Layout layer names to CADSTAR layer 
numbers. Used during export of a Layout design to CADST AR. 

[PROTELXMAPPING] Matches Protei layer names to Layout layer names. Used 
during import of a ProteI design to Layout. 

[PROTELBMAPPING] Matches Layout layer names to ProteI layer names. Used 
during export of a Layout design to ProteI. 

[PADSXMAPPING] Matches PADS layer names to Layout layer names. Used 
during import of a PADS design to Layout. 

[PADSBMAPPING] Matches Layout layer names to PADS layer names. Used 
during export of a Layout design to PADS. 

If you edit the LAYOUT.INI file to match your standard layer usage, and then keep 
it in the WINDOWS directory, it will apply to all of your designs. If you keep a local 
copy of the edited LAYOUT.INI in a separate job directory, the LAYOUT.INI in 
your local directory will be used for the designs in that directory. 

~ Tip If you edit the LAYOUT.INI in the WINDOWS directory, you should also 
keep a copy of it under a different name (such as LAYOUT.USR), so that if you 
receive a new shipment of Layout with its new LAYOUT.INI, you will be able to 
"cut and paste" your naming conventions from LAYOUT.USR to the new 
LAYOUT.INI, thus saving you the effort ofretyping them. 
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[PCADXMAPPING] 
COMP=TOP 
SOLDER = BOT 
INT1=INI... 

[PCADBMAPPING] 
TOP=COMP 
BOT=SOLDER 
INI = INTI... 

[TANGOXMAPPING] 
TOP = TOP 
BOTTOM=BOT 
POWER = PWR ... 

[TANGOBMAPPING] 
TOP = TOP 
BOT = BOTTOM 
PWR=POWER ... 

Chapter 17 Importing and exporting files 

RJ Note PCAD, CadStar, and PADS, you can specify copper layers using the 
keyword COPPER. 

OrCAD Layout for Windows User's Guide 249 



Chapter 17 Importing and exporting files 

MAX Interchange 
Layout can read an ASCII Layout board file (.MIN) and write a binary board file 

. (.MAX). It can also read a Layout board file (.MAX) and write an ASCII Layout 
board file. 

To import a MAX Interchange file (.MIN) into a Layout board file (.MAX) 

1 Choose MAX Interchange from the Import menu in the session frame. 

2 When the MAX Intercbange Notation Input dialog box appears, select a file with 
a .MIN extension and choose the Open button. 

3 When the MAX Board Output dialog box appears, enter a file name with a 
.MAX extension, and choose the Save button. 

4 When the .MIN to MAX Extractor dialog box appears and displays the message, 
"Processing completed," choose the OK button to dismiss the dialog box. 

To export a Layout board file (.MAX) to a MAX Interchange file (.MIN) 

1 Choose MAX Interchange from the Export menu in the session frame. 

2 When the MAX Board Input dialog box appears, select a file with a .MAX 
extension and choose the Open button. 

3 When the MAX Interchange Notation Output dialog box appears, enter a file 
name with a .MIN extension, and choose the Save button. 

4 When the Options dialog appears, select the items that you want to include in the 
exported file and choose the OK button. 

S When the dialog box appears displaying the message, "Processing completed," 
choose the OK button to dismiss the dialog box. 

~ Tip If you suspect that your design file is corrupt, you can export the file to an 
ASCII board file, remove the incorrect data to fix the problem, and then read it 
back into Layout. The export process must be executed from the command line 
using the executable MAXMIN.EXE. Read it back into Layout using the process 
described in To import a MAX Interchange file (.MIN) into a Layout board file 
(.MAX) above. 
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You can easily move a design or library between PCB 386+ to Layout. Layer 
mapping occurs automatically when using this translator. 

In a translated library file, the module insertion point is set for use by pick-and-place 
machines, and the module angle is set to zero. The layer colors of the translated file 
will match those of the PCB 386+ library if the files 386LIB.SF and 386LIB.TCH 
are in the DATA directory, and are used to create the new library file. 

To translate a PCB 386+ board 

1 In the session frame, choose Import and PCB 386+ from the File menu. 

2 In the PCB 386 to MAX Translator dialog box, enter the name and path of the 
existing PCB 386+ file, or use the Browse button to locate the file. . 

3 . Enter the path and file name for the translated file or use the Browse button to 
point to the location. 

4 If you want Layout to prompt you before overwriting an existing board file with 
the same name as the output file, ensure that there is no check in the Overwrite 
existing files check box. 

5 Choose the Translate button . 

. To translate a PCB 386+ library 

1 In the session frame, choose Import and PCB 386+ from the File menu. 

2 In the PCB 386 to MAX Translator dialog box, enter the name and path of the 
existing PCB 386+ file, or use the Browse button to locate the file. If you use the 
Browse button, you may need to choose .MLB in the Use Files of Type drop list. 

3 Enter the path and file name for the translated file or use the Browse button to 
point to the location. The extension of a Layout library file is .LLB. 

4 If you want Layout to prompt you before overwriting an existing board file with 
the same name as the output file, ensure that there is no check in the Overwrite 
existing files check box. 

5 Choose the Translate button. When the translator reads the .MLB extension, it 
prompts you to use the 386LIB.SF and 386Lffi.TCH. 

6 Choose the Yes button. 

RJ Note The files 386LIB.SF and 386Lffi.TCH set up the appropriate colors for the 
library. For example, they make the component outlines more visible, and the drill 
drawing legend invisible. If you have special circumstances, you may want to load 
custom strategy files and technology templates. 

DrCAD Layout for Windows User's Guide 251 



Chapter 17 Importing and exporting files 

CadStar 
You can translate a CadStar or a MAXIlPC file with a .CDI extension into an Layout 
board file with a .MAX extension. After placement and routing, you can export the 
. Layout board file back out to a CadStar board. 

Layout supports CadStar .cm files up to v.7.0. CadStarusers with v.8.0 or higher 
must output in v.7.0. 

To import a CadStar file into Layout 

1 In the CadStar or MAXIlPC software, save your file as an ASCII file with a 
.CDI extension. . 

2 In the Layout session frame, choose Import from the File menu, and select 
CadStar PCB from the ensuing list. 

3 When the CadStar ASCII Input dialog box appears, select the file with the .cm 
extension, then choose the Open button. 

4 When the MAX Board Output dialog box appears, enter a filename with a 
.MAX extension, then choose the Save button . 

. 5 When the Board Template File dialog box appears, select the DEFAULT.TCH 
file, then choose the Open button. DEFAULT.TCH is located in the DATA 
directory. 

6 When the CadStar Extractor dialog box appears and displays the message 
"Processing completed," choose OK to dismiss the dialog box. 

To export a Layout board file back to CadStar 

1 In the Layout session frame, choose Export from the File menu, and select 
CadStar PCB from the ensuing list. 

2 . When the MAX Board dialog box appears, select the Layout board file (.MAX.) 
that you want to export back to CadStar, then choose the Open button. 

3 When the Original CadStar COl dialog box appears, select the original CadStar 
file, then choose the Open button. 

4 When the CadStar Routes dialog box appears, enter a name and select a 
destination for the output file (.ROU) and choose the Save button .. 
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You can translate a PADS-PCB, a PADS-2000, or a PADS-PERFORM file with an 
.ASC extension into an OrCAD binary file with a .MAX extension. 

To import a PADS file into Layout 

1 In the PADS software, choose "Basic units" before you generate an output file. 

2 In the PADS software, choose "All" from the ASCII output selection box. 

3 In the PADS software, save your file as an ASCII file with an .ASC extension. 

4 In the Layout session frame, choose Import from the File menu, then choose 
PADS PCB from the ensuing list. 

S When the PADS-PCB ASCII Input dialog box appears, select the file with the 
.ASC extension, then choose the Open button. 

6 When the MAX Board dialog box appears, enter a filename with a .MAX 
extension, then choose the Save button. 

7· When the Board Template File dialog box appears, select the P ADS.TCH file, 
then choose the Open button. PADS.TCH is located in the DATA directory. 

8 When the PADS-PCB Extractor dialog box appears and displays the message 
"Processing completed," choose OK to dismiss the dialog box. 

To export a Layout board file back to PADS 

1 In the Layout session frame, choose Export from the File menu, and select 
PADS PCB from the ensuing list. 

2 When the MAX Board dialog box appears, select the Layout board file (.MAX) 
that you want to export back to PADS, then choose the Open button. 

3 When the Original PADS-PCB ASCII file dialog box appears, select the original 
PADS file, then choose the Open button. 

4 When the PADS-PCB ASCII Output dialog box appears, enter a name and select 
a destination for the output file (.ROD) and choose the Save button. 
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PCAD 

You can translate a PCAD file with a .PDF extension into an Layout binary file with 
a .MAX extension. To use this translator, you must have both an input .PDF file and 
an input .MDF file. 

A .MDF file (such as GENERIC.MDF, which is supplied with Layout) defmes the 
padstacks associated with each pin type in an input PDIF file. When Layout 
translates the PCAD file, it uses the aperture list to get the padstack infonnation. If 
any pin or type definition was not included in the .PDF file, the program will attempt 
to get the padstack information from the .MDF file. You can create the .MDF file to 
specify the undefmed pin type or defmition. 

Fb Note orCAD recommends using GENERIC.MDF. 

To import a PCAD file into Layout 

1 In the PCAD software, load your padstack defmitions into your design and 
output them with your PDIF file. 

Layout interprets this information and automatically creates the correct padstack 
definitions. If you are unable to load your definitions, you can use the 
GENERIC.MDF file's default, which is that any undefined padstack is 50 mils 
round. 

2 When configuring PDIFOUT, answer Yes to the prompt "Scan and Tag Reserve 
Characters?" 

3 When configuring PDIFOUT, answer No to the prompt "Include Pin Numbers in 
Sub-Component Section?" 

4 When configuring PDIFOUT, answer Compressed to the prompt "Compressed 
or indented format". 

5 When configuring PDIFOUT, save your file as an ASCII file with a .PDF 
extension. 

6 In the Layout session frame, choose Import from the File menu, then choose 
pcAD PCB from the ensuing list. 

7 When the PCAD PDIF dialog box appears, select the file with the .PDF 
extension, then choose the Open button. 

8 When the orCAD Defmitions File dialog box appears, select GENERIC.MDF 
or User-defmed MDF, then choose the Open button. 

9 When the MAX Board dialog box appears, enter a filename with a .MAX 
extension, then choose the Save button. 

10 When the Board Template File dialog box appears, select the DEFAULT. TCH 
file, then choose the Open button. DEFAULT.TCH is located in the DATA 
directory. 

11 When the dialog box appears displaying the message "Processing completed," 
choose OK to dismiss ·the dialog box. 
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To export a Layout board file back to PCAD 

1 In the Layout session frame, choose Export from the File menu, and select 
PCAD PCB from the ensuing list. 

2 When the MAX Board dialog box appears, select the Layout board file (.MAX) 
that you want to export back to PCAD, then choose the Open button. 

3 When the Original PCAD PDIF dialog box appears, select the original PCAD 
file, then choose the Open button. 

4 When the PCAD PDIF Output dialog box appears, enter a name and select a 
destination for the output file (.ROD) and choose the Save button. 
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Protei 
You can translate a ProteI Autotrax file or a ProteI for Windows file with a .PCB 
extension into an orCAD binary file with a .MAX extension. 

To import a Protei board into Layout 

1 In the ProteI for Windows software, save your file as an ASCII file with a .PCB 
extension. 

2 In the Layout session frame, choose Import from the File menu, then choose 
ProteI PCB from the ensuing list. 

3 When the ProteI PCB dialog box appears, select the file with the .PCB 
extension, then choose the Open button. 

4 When the MAX Board dialog box appears, enter a filename with a .MAX 
extension, then choose the Save button. 

S When the Board Template File dialog box appears, select the PROTEL. TCH 
file, then choose the Open button. PROTEL.TCH is located in the DATA 
directory. 

6 When the ProteI Extractor dialog box appears and displays the message 
"Processing completed," choose OKto dismiss the dialog box. 

To export a Layout board file back to Protei 

1 In the Layout session frame, choose Export from the File menu, and select ProteI 
PCB from the ensuing list. 

2 When the MAX Board dialog box appears, select the Layout board file (.MAX) 
that you want to export back to ProteI, then choose the Open button. 

3 When the Original ProteI dialog box appears, select the original ProteI file, then 
choose the Open button. 

4 When the ProteI Output dialog box appears, enter a name and select a 
destination for the output file (.ROU) and choose the Save button. 

256 OrCAD Layout for Windows User's Guide 



Tango 

Chapter 17 Importing and exporting files 

You can translate a Tango Series II file or a Tango-PCB PLUS file with a .PCB 
extension into an OrCAD binary file with a .MAX extension. 

To import a Tango board into Layout 

1 In the Tango Series II or Tango-PCB PLUS software, save your file as an ASCII 
file with a .PCB extension. 

2 In the Layout session frame, choose Import from the File menu, then choose 
Tango PCB from the ensuing list. 

3 When the Tango Input PCB dialog box appears, select the file with the .PCB 
extension, then choose the Open button. 

4 When the MAX Board dialog box appears, enter a filename with a .MAX 
extension, then choose the Save ,mtton. 

5 When the Board Template File dialog box appears, select the DEFAULT.TCH 
file, then choose the Open button. DEFAULT.TCH is located in the DATA 
dir~ctory. 

6 When the Tango Extractor dialog box appears and displays the message 
"Processing completed," choose OK to dismiss the dialog box. 

To export a Layout board file back to Tango 

1 In the Layout session frame, choose Export from the File menu, and select 
Tango PCB from the ensuing list. 

2 When the MAX Board dialog box appears, select the Layout board file (.MAX) 
that you want to export back to Tango, then choose the Open button. 

3 When the Original Tango File dialog box appears, select the original Tango file, 
then choose the Open button. 

4 When the Tango Output dialog box appears, enter a name and select a 
destination for the output file (.ROU) and choose the Save button. 
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DXF import and export 
Layout can translate files in and out of mechanical CAD (MCAD) systems, such as 
orCAD Visual CADD and AutoCAD. The MAXDXF program was written to do 
three things: 

• Translate a mechanical drawing in DXF format to Layout MAX format to defme· 
board outlines, component keep-out areas, component height restriction areas, 
and mounting holes. 

• Translate a complex component defmition in DXF format to Layout MAX 
format to defme component outlines, net attributed obstacles (a track that takes 
the netname from the pin to which it is attached), copper obstacles (a custom pad 
shape or a component shield). . 

• Translate a Layout MAX file to DXF format to create customizable assembly 
drawings and customizable drill drawings. 

Fb Note Since neither the copper pour or thermal reliefs are included in the DXF 
output, the translated DXF should not be used to create artwork for your copper 
layers. It is possible for Layout to create DXF output which can be input to a CAD 
program to create copper layer artwork. This is accomplished in the Post Process 
Setup dialog box. For more information see Chapter 15: Post Processing. 

MAXDXF.INI 

You manage the MAXDXF process using the MAXDXF.INI file, which should be 
installed in the DATA subdirectory (where your DEFAULT.TCH technology 
template is located). The MAXDXF.INI file defines the layer setup and the actual 
mapping of text and obstacle layers during the translation. 

The file can be edited with any ASCII editor. The software that parses the file will 
tolerate extra blank lines and extra spaces or tabs as long as you follow a few rules: 

• Section names are enclosed in square brackets as in: [VERSION]. 

• One section or defmition per line. 

• An equal sign separates each defmition mto two pieces: A LAYOUT LAYER = 
AN MCAD LAYER. 

• There are also lines defining system control variables as NAME OF 
VARIABLE = VALUE. These control variables may be repeated as often as 
needed. In theory, you could specify new control values before every layer. 

The MAXDXF INI file itself contains comments introduced by a semicolon to 
document the system control variables. 
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The default MAXDXF.OO file is located in the DATA directory. This way, you can 
keep custom MAXDXF files in the directories that Layout looks in first, so that they 
will be used instead of the default. Layout searches for MAXDXF.INI in the 
following order: 

• 

• 

• 
• 

The current directory 

The directory in which MAXDXF.EXE is located 

The Windows directory 

The Layout DATA directory 

Expanded layer mapping 

When MAXDXF converts a Layout MAX file to DXF format, the 30 original layers 
in the MAX file explode to more than 100 layers in the DXF file. The MAXDXF.INI 
file specifies how Layout objects and layers are mapped to DXF layers to allow easy 
customization of the DXF. 

For instance, if you translated a 30-layer board from Layout onto 30 AutoCAD 
layers, you could not easily create an assembly drawing showing component 
outlines, pads, the board outline, component reference, and component value, while 
omitting the tracks and vias. But, by splitting our objects across multiple layers, you 
can create a custom assembly drawing by turning the Layers on and off in AutoCAD. 

Consider the following example. To create an assembly drawing for the TOP layer of 
a board, you would start by making all ofyciur AutoCAD layers invisible. Then, you 
would make the TOP layer visible so you could see the pads, the TEXT_ASYTOP 
layer visible so you could see the component text, and the OBS_ASYTOP layer 
visible so that you could see the component outlines. Then, you could print or plot. 

W See For information on troubleshooting MAXDXF, see Troubleshooting in the 
Layout online help. 

To translate a DXF file into Layout 

1 Check the MAXDXF.OO file to ensure that the layer names used in MCAD map 
properly to the layer names used in Layout. 

2 From the session frame File menu, choose Import and DXF to MAX. 

3 Fill in the dialog with the names of your DXF file, technology file, and.OO file. 

4 Choose the Translate button. 
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To translate a Layout board file (.MAX) into DXF 

1 From the session frame File menu, choose Export and MAX to DXF. 

2 Fill in the dialog with the names of your MAX file and .00 file. 

3 Press the Translate button. 

When all DXF entities are on the default layer 0 

1 Create a MAXDXF.OO file which uses the AutoCAD layer 0 twice: once to 
translate all the polygons in the DXF file into obstacles and once to translate the 
circles into holes. For example: 

[OBSTACLE] 

TOP=O 

[MECHANICAL] 

UNPLATED_MOUNTING_HOLES = 0 

The polygons will all be on the TOP layer along with one extra obstacle for each 
hole. 

2 Select and then edit the obstacles in Layout to move them to the proper layer and 
change them to the appropriate Obstacle type: either board outline or keep-out. 
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To merge separate DXF files into a single Layout layer 

1 Make a copy of your MAXDXF.INI file in the project directory under a different 
name. For example: copy MAXDXF. INI temp. 

2 Edit the temporary file (in this example, "temp") and delete everything but the 
lines for the defmitions and sections you need: 

[MECHANICAL] 

BOARD_OUTLINE 

COMP_KEEPOUT_ALL 

PLATED_MOUNT ING_HOLE S 

file1.dxf 

file2.dxf 

file3.dxf 

3 When MAXDXF prompts you for the name of the input DXF file, give it the 
temporary file name (in this case, "temp") instead. MAXDXF will read the three 
files listed in the example and translate them into the appropriate Layout objects 
within your output MAX file. 

To import metric DXF files and create metric Layout board files from 
them 

In your MAXDXF.INI file set the UNITS_DIVISOR to 25.4: 

UNITS_DIVISOR=25.4 

2 When you are prompted for a technology template, select a technology template 
which is in millimeters .. 

To interpret AutoCAD traces 

1 Edit the [COPPER] section of your MAXDXF.INI file to include those layers 
that have AutoCAD traces you want to defme as polygons. 

2 Edit the [OBSTACLE] section of the file to include the layers that have 
AutoCAD traces you want to defme as lines. 

RJ Note If a layer contains both polygon and line AutoCAD traces, you must 
reference that layer twice (in both the [COPPER] and [OBSTACLE] sections) and 
then delete the undesired objects from within Layout. 
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Understanding the files used with Layout 

Appendix A: Understanding the files used with Layout describes the various files 
used with Layout, including board files, technology templates, and strategy files. 

Appendix A 





Appendix A 

Understanding the files used with 
Layout 

Layout uses a variety of files, some that you can modity, and some that store vital 
project resources. This chapter describes the files, including their contents, function, 
and how to access them. 

Fb Note .MAX,. TCH, and .LLB files use the same binary fonnat. The different 
extensions reflect their different purposes. 

System files 

LSESSION.INI The LSESSION.INI manages access to other applications through 
the session frame. When you install Layout, you may have to edit the path in the 
LSESSION.INI to include the correct path to OrCAD Capture for Windows. 
LSESSION.INI is found in the Layout directory. 

You can access LSESSION.INI by choosing Edit App Settings from the Tools menu 
in the session frame. The file opens in a text editor. Scroll to the bottom of the file, 
edit the paths to point to the directories where the applications are located (for 
example, C : \ ORCADWIN\) and save and close the file. Then, choose Reload App 
Settings from the Tools menu. Layout immediately recognizes the paths without 
exiting Layout or rebooting. 

LAVOUT.lNI The LAYOUT.INI file contains vital infonnation about Layout and 
your design. During installation, the LAYOUT.INI is placed in the Windows 
directory; a copy of the LAYOUT.INI file must be located in the Windows directory 
in order for OrCAD Capture for Windows to generate a netlist or perform forward 
annotation to Layout. It is recommended that you edit this file only if necessary. The 
LA YOUT.INI includes set up infonnation for the following areas: 

• User preference settings for the PCB translators 

• The list of currently available libraries 

• Properties that are passed from Capture to Layout 

• Post processing 

• Custom reports 

• Default net colors by weight (priority for routing) 
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SYSTEM.PRT SYSTEM.PRT is an ASCII file that contains information 
regarding the correspondence between part names (the electrical part description, 
such as 74LSOO or .01 UP) and footprints (the physical description of the part, such as 
DIP14 or SMiCCHIP/0805). That is, the file acts as a back-up to map parts to 
footprints if they are not defmed in the schematic. 

fI7'~ Caution You should not modify SYSTEM.PRT. Layout provides a 
customizable version of this file called USER.PRT. 

USER.PRT USER.PRT is a copy of the SYSTEM.PRT file that you can 
customize. The USER.PRT file is located in the LAYOUT\DATA directory. 

USER.PR T is automatically updated during the ECO process. Each time an electrical 
part description is encountered and ECO is unable to match it to a footprint, ECO 
will prompt the user to enter a footprint name from the browser, once the footprint is 
selected, ECO enters the reference into USER.PRT. 

Fb Note Capture does not allow you to create a netlist with a missing footprint. 
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Board templates 

Appendix A Understanding the files used with Layout 

Board templates consist of a board outline and basic design rules. They are a 
foundation upon which to build a design. When starting a new design, you are asked 
to load a template as the fIrst step in board creation. Layout's board templates offer 
70 board outlines which are illustrated in the document OrCAD Layout for Windows 
Footprint Libraries. The board outlines use the same design rules as Layout's 
technology template DEFAULT.TCH which is described in the section Technology 
templates in this chapter. 

~ Tip You can create custom templates. See Creating custom templates in 
Chapter 5: Setting up the board. 

Technology templates 
Technology templates enable designers to set design standards for their boards 
quickly and easily. It may be easiest to think of a technology template as a printed 
circuit board without physical objects or net information. 

Technology templates can contain anything that can be defmed and included in a 
board design, except the netlist. At the highest level, technology templates specify 
the manufacturing complexity of the design, and set the rule up for the component 
type used most predominantly on the board. In particular, technology templates can 
defme the board layer structure, default grids, spacing, track widths, pads tack 
descriptions, and default colors. A technology template can also include Gerber 
output settings. 

Some objects on the board must be flagged as non-electric in a technology template, 
or they are deleted during Layout's AutoECO process. These include tooling holes or 
mounting holes, stiffeners, and mechanical parts, and any other parts on the board 
that are not defmed in the schematic. 

You can load a technology template at any time. 
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When you load a technology template into a design, the template replaces certain 
settings in the design, and ignores others. It replaces the following information: 

• Placement strategy 

• Routing strategy 

• Number of defmed layers, layer names, layer properties (such as spacing) 

• Grids 

• Padstacks 

The following information is ignored when you load a new technology template: 

• Colors 

• Packages 

• Symbols 

• Components 

• Nets 

• Connections 

• Obstacles 

• Text 

• Everything else is ignored 
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With a technology template, you establish the level of manufacturing complexity 
your design requires. There are three levels of manufacturing technology defmed 
(per IPC-D-275). They provide three levels of set up, placement, and routing rules 
that reflect increased sophistication of tooling, materials, or processing, and 
ultimately cost. 

Level A (General Design Complexity. Preferred manufacturing.) This 
technology allows one track between standard DIP IC pins. 

Level B (Moderate Design Complexity. Standard manufacturing.) This 
technology allows two tracks between standard DIP IC pins. 

Level C (High Design Complexity. Reduced ease of manufacturing.) 
This technology allows three tracks between standard DIP IC pins. 

The technology templates included with Layout are described below. 

1BET_ANY.TCH Based on Level A as described above, one track is allowed 
between standard DIP IC pins; a standard DIP IC pin has 62 mil pads and 38 mil 
drills; routing and via grids are 25 mils; placement grid is 100 mils; route spacing is 
12 mils. . 

2BET_THR.TCH Based on Level B as described above, 2BET_THR.TCH is used 
for through-hole boards; two tracks are allowed between standard DIP IC pins; a 
standard DIP IC pin has 54 mil pads and 34 mil drills; routing and via grids are 20 
mils; placement grid is 100 mils; route spacing is 8 mils. 

2BET_SMT.TCH Based on Level B as described above, 2BET_SMT.TCH is 
used for surface-mount or mixed-technology boards; two tracks are allowed between 
standard DIP IC pins; a standard DIP IC pin has 54 mil pads and 34 mil drills; 
routing and via grids are 8!t3mils; placement grid is 50 mils; route spacing is 8 mils. 

3BET_ANY.TCH Based on Level C as described above, 3BET_ANY.TCH uses 
standard DIP IC pin has 50 mil pads and 34 mil drills; routing and via grids are 12Y2 
mils; placement grid is 50 mils; route spacing is 6 mils. 

CERAMIC.TCH Used to set up ceramic chip modules. 

DEFAULT.TCH . Default technology template for typical designs. Also used for· 
board translators. Based on Level A as described above, one track is allowed 
between standard DIP IC pins; a standard DIP IC pin has 62 mil pads and 38 mil 
drills; routing and via grids are 25 mils; placement grid is 100 mils; route spacing is 
12 mils. 

HYBRID.TCH Used for hybrid chips. 

JUMP5535.TCH Single-layer boards, 55 mil vias with 35 mil drills. 

JUMP6035.TCH Single-layer boards, 60 mil vias with 35 mil drills. 

JUMP6238.TCH Single-layer boards, 62 mil vias with 38 mil drills. 

MCM.TCH Used for setting up multichip modules. 

METRIC.TCH Metric boards. If you are designing a board that is using metric 
units, you should start with the METRIC.TCH technology template to achieve the 
best precision. 
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Netlist files 

MAX files 

MAX netlist files (.MNL) are Layout binary netlists created by the Import Netlist 
commands on the session frame's Import menu or orCAD Capture for Windows. 
They are used by AutoECO to create or modify printed circuit boards. 

.MAX files are Layout binary board files. The AutoECO process creates a .MAX file 
by combining the binary schematic netlist (.MNL) and the board or technology 
template (.TCH) you specify when you create a new design. 
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There are two types of strategy files in Layout: placement strategy files and routing 
strategy files. 

Used for autoplacement, placement strategy files determine the placement of 
components based on different priorities, such as whether clusters are used, whether 
gates and pins are to be swapped, or whether you want the fastest placement. 

Used for autorouting, routing strategy files determine which default routing layers to 
use, when to use vias, which direction tracks should travel, which colors to use for 
routes, and the size of the active routing window. 

Predefined strategy files come with Layout for Windows. The files are optimized for 
specific types of boards based on the type of components on the board, the number of 
layers enabled for routing, and the preferred track direction on the top layer. When 
creating your own strategy file, it is easiest to modify one of the existing files. 

If you attempt to load two strategy files, the old strategy file is automatically 
overwritten by the new one. For example, if you load a placement strategy file, and 
then when it is time to route the board, you load a routing strategy file, the routing 
strategy is recognized by Layout. 

The routing strategy files provided with Layout are listed below. Note that the 
number of board layers given indicates the number of routing layers (not total layers ) 
on a board. 

WI See For information on placement strategy files and for a list of the placement 
strategy files included with Layout, see Chapter 2: Using auto placement in the 
DrCAD Layoutfor Windows Autoplacement User's Guide. 
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STD.SF is the standard strategy file that is automatically loaded into each board 
design as it is translated into Layout's binary format. All other strategies are derived 
from this one. It exists as a separate file in the DATA directory and must be present 
in the directory in order to translate a board into Layout. You can also load this 
strategy file and use it with boards that were not translated. 

The SMI strategy files should only be used for multilayer surface-mount or mixed­
technology boards with active components on the component side only. The SM2 
strategy files should only be used for multilayer surface-mount or mixed-technology 
boards with active components on the component and solder sides. 

• A 2, 4, 6, or 8 indicates the number of routing layers (not total layers ) on a 
board. 

• THR is for through-hole boards. 

• SMD is for two-layer, single-sided, or double-sided surface mount, or mixed­
technology boards. 

• SM! is for single-sided surface mount boards. Use these strategy files for 
multilayer SMT or mixed-technology boards with active components on the 
component side only. 

• SM2 is for double-sided surface mount boards. Use these strategy files for 
multilayer SMT or mixed-technology boards with active components on the 
component and solder sides. 

• An H indicates a horizontal primary direction of routing on layer one; a V 
indicates a vertical primary direction of routing on layer one. 

RJ Note The strategy files included with Layout have been optimized to route 
typical surface-mount technology (SMT) or through-hole boards of two to eight 
routing layers. For boards with more than eight routing layers, modify an eight­
layer strategy file, keeping the same pattern. 

2_SMD_H.SF Used for a two-layer single-sided or double-sided surface-mount 
or mixed-technology board, with layer one horizontal. 

2_SMD_V.SF Used for a two-layer single-sided or double-sided suiface-mount 
or mixed-technology board, with layer one vertical. 
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2_THR_H.SF Used for a two-layer through-hole board, with layer one 
horizontal. 

2_THR_V.SF Used for a two-layer through-hole board, with layer one vertical. 

4_SM1_H.SF Used for a four-layer single-sided surface-mount or mixed­
technology board, with layer one horizontal. 

4_SM1_ V .SF Used for a four-layer single-sided surface-mount or mixed­
technology board, with layer one vertical. 

4_SM2_H.SF Used for a four-layer double-sided surface-mount or mixed­
technology board, with layer one horizontal. 

4_SM2_V.SF Used for a four-layer double-sided surface-mount or mixed­
technology board, with layer one vertical. 

4_THR_H.SF Used for a four-layer through-hole board, with layer one 
horizontal. 

4_THR_ V.SF Used for a four-layer through-hole board, with layer one vertical. 

6_SM1_H.SF Used for a six-layer single-sided surface-mount or mixed­
technology board, with layer one horizontal. 

6_SM1_V.SF Used for a six-layer single-sided surface-mount or mixed­
technology board, with layer one vertical. 

6_SM2_H.SF Used for a six-layer double-sided surface-mount or mixed­
technology board, with layer one horizontal. 

6_SM2_ V .SF Used for a six-layer double-sided surface-mount or mixed­
technology board, with layer one vertical. 

6_THR_H.SF Used for a six-layer through-hole board, with layer one 
horizontal. 

6_THR_V.SF Used for a six-layer through-hole board, with layer one vertical. 

8_SM1_H.SF Used for an eight-layer single-sided surface-mount or mixed­
technology board, with layer one horizontal. 

8_SM1_V.SF Used for an eight-layer single-sided surface-mount or mixed­
technology board, with layer one vertical. 

8_SM2_H.SF Used for an eight-layer double-sided surface-mount or mixed­
technology board, with layer one horizontal. 

8_SM2_V.SF Used for an eight-layer double-sided surface-mount or mixed­
technology board, with layer one vertical. 

8_THR_H.SF Used for an eight-layer through-hole board, with layer one' 
horizontal. 

8_THR_ V .SF Used for an eight-layer through-hole board, with layer one 
vertical. 
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FAST_H.SF Used for quickly checking on a particular placement, with layer one 
horizontal. 

FAST_V.SF Used for quickly checking on a particular placement, with layer one 
vertical. 

JUMPER_H.SF Used for boards with jumper layers, with layer one horizontal. 

JUMPER_ V .SF Used for boards with jumper layers, with layer one vertical. 

STD.SFUsed for the default routing strategy. It is automatically loaded into each 
board's design if the board is translated into Layout's binary format. You can also 
use this strategy file with boards that are not translated. 

VIARED_H.SF Used for a via-reduce sweep on a completely routed board, with 
layer one horizontal. 

VIA RED_V. SF Used for a via-reduce sweep on a completely routed board, with 
layer one vertical. 

m See For information on modifying the parameters set in strategy files, see 
Chapter 3: Using routing strategy files in the DrCAD Layout for Windows 
Autorouter User's Guide. 
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Library files are Layout footprint libraries that contain the component templates that 
are used to design a printed circuit board. Layout provides over 3000 footprints in its 
libraries. You may also create new footprints and custom libraries. Library files are 
located in the LA YOUT\LIBRARY directory and have .LLB extensions. 

W See For information on using footprint libraries, see Part III: Libraries. 

Report files 
Layout generates two files that report Layout session information . 

. LOG LA YOUT.LOG, also called the session log, keeps track of all session­
related activity while in Layout. New session information is appended to previous 
session iriformation, so you may want to delete LA YOUT.LOG occasionally, as the 
file becomes very large over time . 

. LlS .LIS files are output error listings arid activity lists. In the LffiRARY 
directory, these files list the footprints in each library. 
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active layer In Layout, the design layer that 
is currently selected or visible on the screen. The 
active layer is the layer that appears in the 
toolbar's layer drop-down list. 

algorithm A procedure for solving a problem, 
usually mathematical. 

analog circuit A circuit comprised mostly of 
discrete components (resistors, capacitors, 
transistors) that produces data represented by 
physical variables such as voltage, resistance, or 
rotation. 

annular ring A circular strip of conductive 
material that surrounds a hole on the printed 
circuit board. 

ANSI Acronym for American National 
Standards Institute, an organization formed by 
industry and the U.S. government to develop 
trade and communication standards. 
Internationally, ANSI is the American 
representative to the ISO (International 
Standards Organization). See also ASCII. 

anti-copper A zone that defines an area 
within a fill zone that is not to be filled with 
copper. 

aperture A hole, similar to ·the aperture of a 
camera, that is used for photoplotting. Apertures 
are available in various sizes and shapes. 

aperture list A text file containing the 
dimensions for each of the apertures used to 
photoplot printed circuit board artwork. 

arc A segment defined as an arc (one-quarter 
of a circle). 

Glossary 

ASCII Acronym for American Standard Code 
for Information Interchange; a seven-bit code­
based on the first 128 characters of the ANSI 
character set--that assigns numeric values to 
letters of the alphabet, the ten decimal digits, 
punctuation marks, and other characters such as 
Backspace, Carriage Return, and Line Feed. 
ASCII is the most widely used character-coding 
set, and as such enables different applications 
and computers to exchange information. See also 
ANSI. 

assembly drawing A document that relates 
information pertaining to the manufacture of a 
printed circuit board. This information may 
include the board outline, component outlines 
and reference designators, part values, and other 
documentation. 

attribute See property. 

autodimension In Layout, a tool for 
automatically measuring and documenting the 
dimensions of your printed circuit board design. 
See also automatic dimensioning. 

AutoDFM Acronym for automatic design for 
manufacturability. When you execute AutoDFM, 
Layout checks the board to ensure that it meets 
manufactumbility requirements. 

AutoECO Acronym for automatic 
engineering change order. Layout's AutoECO 
command translates schematic netIist 
information from OrCAD Capture for Windows 
into Layout. See also forward annotation. 

automatic component placement 
Software that automatically optimizes 
component placement on a printed circuit board. 
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automatic dimensioning A computer­
aided drafting function that automatically 
generates-dimensions, leaders, arrowheads, and 
other similar items that make up a complete set 
of documented dimensions. See also 
autodimension. 

autorouting Automatic routing performed by 
a computer application based on a set of rules. 

axial leads Leads coming out the ends and 
along the axis of a resistor, capacitor, or other 
axial part, rather than out the side. 

back annotate In Layout, to transmit data, 
such as component renames and gate and pin 
swaps, back to the schematic. See also forward 
annotate. 

BGA Acronym for Ball Grid Array. Leadless 
array packaging technology in which solder balls 
are mounted to the underside of the package and 
are flowed fQr attachment to printed circuit 
boards. 

blind via A via that reaches only one surface 
layer on one side of a multilayered printed circuit 
board. See also via, buried via. 

block A specific portion of the design that is 
marked and manipulated as a single entity. 

board template A file that contains a board 
outline and some design rules. It may also 
contain drawing formats, dimensions, prep laced 
components, and tooling holes. See also 
technology template. . 

bulletin board system A computer system 
used for electronically sending and receiving 
bulletins, messages, and files through modems. 
Abbreviated BBS. 

buried via A via that does not reach a surface 
layer on either side of a multilayered printed 
circuit board. That is, the via transcends only 
inner layers of the printed circuit board. See also 
via, blind via. 
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CAD Acronym for computer-aided design. 
Software used for general or specialized design 
uses for architectural, mechanical, or electrical 
design. 

CAE Acronym for computer-aided 
engineering. Software for analyzing designs 
created on a computer or elsewhere and entered 
into the computer. Engineering analysis includes, 
but it not limited to, structural or electronic 
circuit analysis. 

CAM Acronym for computer-aided 
manufacturing. Software used in all development 
phases of an information system including 
analysis, design and programming. 

clusters A group of components that are 
interrelated. Components in a cluster are placed 
in close proximity on the board. This keeps the 
connections on the printed circuit board short so 
that the board is easier to work with. 

COB Acronym for chip on board. Component 
packaging technology in which bare integrated 
circuits are attached directly to the surface of a 
substrate and interconnected to the substrate 
most often by means of microscopic wires. 

component A set of primitives (tracks, pads, 
text) that comprise a single entity. Each 
component is identified with a unique reference 
designator on a printed circuit board. Printed 
circuit board assemblies consist of components 
affIXed to a common surface and connected by 
copper tracks. See footprint 

component density The quantity of 
components ona unit area of a printed circuit 
board. 

component hole A hole in the printed 
circuit board that corresponds to a pin or wire of 
a component. This hole serves the dual function 
of attaching the component to the board, and 
establishing the electrical connection between 
the pin or wire and the remainder of the board 
circuitry. 



component library A Layout file that 
contains the footprint patterns for a number of 
components. 

component side The surface layer of a board 
on which most components are placed. 
Component side is also referred to as the top side 
ofthe board. See also solder side. 

connection An unrouted, partially routed, or 
completely routed path between two pads. In a 
net with n pads, there are exactly n-l 
connections. 

copper zone An area on a board des.igned to 
be covered with copper when the board IS 

manufactured. Also known as a "metal zone." 

cross hatching The breaking up oflarge . 
conductive areas by the use of a pattern of lines 
and spaces in the conductive material. 

cross probing When intertool 
communication is enabled in Capture, selecting 
objects in Capture causes the corresponding 
objects to be highlighted in Layout. Also, 
selecting objects in Layout causes the 
corresponding objects to be highlighted in 
Capture. Both applications must be open. See 
also intertool communication. 

current layer See active layer. 

.... ~ ..... ;/ .. 

datum A specific location (a point) that serves 
as a reference to locate a printed circuit board 
pattern or layer for manufacture. 

default In Layout, a parameter whose value is 
preset by OrCAD. 

density On a printed circuit board, the degree 
to which components are packed on the board. 
Generally, the density is given as the number of 
square inches per equivalent IC; a lower number 
indicates a more dense board. 

Glossary 

design rule A guideline that specifies any of 
a number of parameters for the printed circuit 
board. These may include minimum clearance 
between items that belong to different nets, or 
connection rules. Also, these rules may include 
specifications for track width to c~ a given 
current, maximum length for clock lm~s, 
termination requirements for signals With fast 
rise and fall times, and so on. 

Design Rules Check (DRC) A feature that 
checks the printed circuit board layout for 
violations of pad and track isolations. 

design-rule checking The use ofan 
algorithm to perfonn continuity verification of 
all conductor routing in accordance with 
appropriate design rules. 

DFM Acronym for Design for Manufacture. 
See AutoDFM. 

discrete components Components with 
three or fewer electrical connections (for 
example, resistors, or capacitors). 

dispersion See fanout. 

DRC Acronym for design rules check. See 
Design Rules Check. 

drill chart A table that appears on the 
DRLDWG layer of the board showing the 
current counts, locations, and sizes of the holes 
to be drilled into the printed circuit board. 

drill diameter The actual size of the drill 
body. 

DXF A graphics fonnat created by AutoCAD. 
This is an acronym for Drawing Interchange File. 
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ECl Acronym for Emitter-Coupled Logic. A 
type of bipolar transistor that has extremely fast 

. switching speeds. 

EOA Acronym for Electronic Design 
Automation. Software and hardware tools used to 
ascertain the viability of an electronic design. 
These tools perform simulation. synthesis, 
verification, analysis, and testing of the design. 

EOIF Acronym for Electronic Design 
Interchange Format. A standard published by the 
EIA (Electronic Industries Association) that 
defines the semantics and syntax for an 
interchange format that communicates electronic 
designs. 

EIC Acronym for Equivalent Integrated 
Circuit. A standard method for determining the 
number of components on a board. The EIC is 
determined by taking the number of component 
pins on the printed circuit board and dividing by 
16. 

electrical check The process of checking the 
printed circuit board to ensure that the 
connections thereon match those specified in the 
netlist. 

Extended Gerber See Gerber (274-X). 

fanout The process of creating dispersion vias 
for SMT devices on your printed circuit board. 
The dispersion vias are connected to SMT 
devices by via stringers. 

feed-through hole See via. 

fill zone A zone that defmes an area to be 
filled by copper. See also copper pour. 

footprint The physical description of a 
component. It consists of three elements: 
padstacks (thrucodes), obstacles, and text. 
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forward annotate The process of sending 
netlist data in the form of an .MNL file from 
orCAD Capture for Windows (or other 
schematic capture application) to Layout. 

FPGA Acronym for Field Programmable 
Gate Array. A logic chip that is programmable 
and has a high density of gates. 

FTP Acronym for File Transfer Protocol. a 
highly reliable file transfer protocol that is used 
almost exclusively over the internet. FTP should 
be used for both binary and ASCII transfers. 
However, data files should be transferred in 
binary format. 

gate swap The exchange of identical gates in 
order to decrease route lengths. 

Gerber (274-0) A file format that can be read 
by Gerber and other photoplotter systems that 
require separately or previously defmed aperture 
lists. 

Gerber (274-X) A file format that can be read 
by Gerber photoplotters that accept embedded 
aperture lists. Also known as Extended Gerber. 

Gerber data A type of data that consists of 
aperture selection and operation commands and 
dimensions in X- and Y-coordinates. The data is 
generally used to direct a photoplotter in 
generating photoplotted artwork. 

Gerber photoplotting A method of 
transferring printed circuit board design 
information to film. 

Gerber table The Gerber table is the plot area 
that will be output to Gerber. This area may 
include the board and peripheral items such as 
the drill chart or comments. 

global layer When you load a netlist file, 
Layout places all connections in the netlist on a 
global layer. . 



grid In Layout, all design elements are placed 
on ,the board according to five grids: routing, via, 
dot, place, and detail. A grid is a set of ' 
orthagonallines that defme areas of the board 
and facilitate component and routing feature 
placement. 

ground plane An area on the printed circuit 
board, usually an entire layer, that provides a 
common ground connection for all component 

growID pm, ""d ofuec~OnnectiODS' 

heatsink A mechanical device that is made of 
a high thermal-conductivity material that 
dissipates heat generated by a component or 
assembly. 

heuristics A method of routing that consists 
of repeatedly attempting to apply very simple 
routing patterns to unrouted connections in order 
to complete the routing quickly and cleanly. 
Typically, heuristics are used for memory and 
short point-to-point routing. 

highlight Graphical emphasis that is given to 
text, components, or other objects when they are 
selected for an action. 

hole legend See drill chart. 

HP-GL Acronym for Hewlett-Packard 
Graphics Language, which is a plotter protocol 
developed by Hewlett-Packard. 

HP-GL2 An extension of HP-GL that supports 
polygon fills, wide lines, and other methods of 
plotting complex shapes. 

Glossary 

I 
IGES Acronym for initial graphic exchange 
specification, which is a graphics format for 
transferring CAD/CAM information. 

interactive routing Routing in which 
individual connections are entered into the 
database manually by the user with the aid of 
information such as ratsnests, DRC rules, or 
DFMrules. 

intertool communication A capability that 
allows orCAD EDA tools to share information 
for display and transfer. 

isolation The clearance around a pad, track, 
zone, or via that defmes the nearest approach 
allowed by conductors of another signal set. 

IPC Acronym for Institute for Interconnecting 
and Packaging Electronic Circuits. An 
association in the printed circuit board industry 
that provides standards to enhance commonality 
of designs. 

ITC Acronym for intertool communication. 
See intertool communication. See also cross 
probing. 

jumper wire A discrete electrical component 
or wire that is used to make electrical 
connections between points for which copper 
etch does not exist due to board density or some 
other factor. 

. .. ~. 
keep-out An area fill within which no routing 
is allowed. 
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land In Layout, the copper pad needed for a 
surface mount pin. 

layer One in a series of levels in a printed 
circuit board design on which tracks are arranged 
to connect components. Vias connect tracks and 
zones between layers. Layout allows a maximum 
of30 layers, 16 of which can be copper. 

layer marker An object on a board layer that 
indicates the layer's physical number as counted 
from the top layer. Used for copper layers only. 

layout A scale drawing of a printed circuit 
board, its components, and its electromechanical 
connections. 

Lee Acronym for Leaded Chip Carrier. A 
chip carrier that is square and contains pin 
connectors on all four sides. Implementations 
include the PLCC (plastic LCC) and CLCC 
(ceramic LCC). 

library In Layout, a collection of footprints or 
templates designed to facilitate printed circuit 
board design creation. 

manual routing Individual connections, in 
the form of vertices, arcs, etc., are entered 
manually into the printed circuit board design 
without the aid or requirement of information 
such as ratsnests. 

matrix In Layout, a tool that creates a 
structure on the board that can be divided into 
cells used for the efficient placement of 
footprints. 

MeAD Acronym for Mechanical Computer 
Aided Design. CAD software specific to 
mechanical engineering. 

mixed component-mounting technology 
A component-mounting technology that uses 
both through-hole and surface-mounting . 
technologies on the same printed circuit board. 
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MNL Acronym for MAX netlist. This is the 
netlist format that is accepted by Layout. 

mounting hole A hole used for the 
mechanical support of a printed board or for the 
mechanical attachment of components to a 
printed board. 

multilayer board A printed circuit board that 
has multiple layers, separated by dielectric 
material, with connectivity between layers 
established by vias or through-holes. This term 
usually refers to a board with more than two 
layers. 

net A logical construct that originates in a 
schematic and is transferred to a board to 
describe required electrical connections. The 
connections may be completed using vias, tracks, 
or zones. See also track. 

netlist A file that lists the interconnections of a 
schematic diagram by the names of the signals, 
modules, and pins to be connected together on a 
printed circuit board. The nodes in a circuit. 

obstacle An outline that represents an object 
on the board that must be taken into account 
during routing. 

opaque graphics In Layout, these are visual 
representations of objects on your printed circuit 
board. These objects are represented in different 
colors if they occupy the same space in the 
board. 



p. 
pad On a printed circuit board, a copper etch 
shape on one or more layers (there may be a hole 
and an isolation surrounding the copper) used for 
connecting a component pin to the printed circuit 
board. The pad indicates where pins of a 
component are placed. 

padstack A numbered list of padstack or via 
stack descriptions. Each description contains a 
pad or via definition, including layer, style, drill 
diameter, size, offset, and solder mask guard 
width. 

pan In Layout, the screen automatically 
scrolls to display successive sections of the board 
when you move the mouse to the screen edge. 

PCB ~n acronym for printed circuit board. 

PGA Acronym for Pin Grid Array. A chip 
package with a high density of pins that is used 
for large amounts ofIlO. 

pin The portion of a component to which an 
electrical connection can be made. 

pin swap The exchange of identical pins in 
order to decrease route lengths. 

pin-to-pin spacing The physical spacing 
between pins on a device. 

placement The position of components on a 
printed circuit board. The process of selecting 
where components will reside on a printed circuit 
board. 

plane layer A layer of copper that may have 
pads and holes that connect to it or pass through 
it. Typically used for the power and ground 
layers, CAD tools output the Gerber file for a 
plane layer in a negative form, meaning that the 
areas without copper are identified. Regular 
copper layers are output in positive form, 
meaning that the areas with copper are identified. 

plated through-hole A through-hole that 
establishes an electrical connection between 

. layers of a printed circuit board by way of a 
metal deposition on the inner surface that dermes 
the hole. 

Glossary 

polar placement The process of placing 
printed circuit board components using polar 
coordinates referenced from a user-derme pole. 
Typically, this is used for test fixtures. 

post processing A term used to collectively 
describe the processes performed after the board 
has been routed in order to produce 
manufacturing information (silkscreens, reports, 
drill tapes, assembly drawings, and so on). 

power plane A copper layer usually 
dedicated to a single signal that is considered to 
be a power supply. The ground plane is a power 
plane that supplies the ground potential. 

property A characteristic of an object that can 
be edited. A property consists of a name and a 
value. Examples of property names are part value 
and color. Their respective property values can 
be something such as capacitor and red. 

..~. .... ~ 
query When you select an object on the 
screen, Layout displays the object properties for 
viewing or editing. You can use Layout's query 
tool to inquire about object properties. . 

radial lead A lead extending out the side of a 
component, rather than from the end. 

ratsnest A straight-line connection between 
two or more pads that indicates an electrical 
connection in the netlist. Ratsnests serve as a 
reminder that the pads must be connected, and 
that, currently, there is no track on the board to 
make that connection. 

reference deSignator A character string 
denoting the type of component and a number 
that is specific to that component 

registration The alignment of a pad on one 
side of the printed circuit board (or layers of a 
multi-layer board) to its mating mad on the 
opposite side. 
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routing Placing conductive interconnects 
between components on a printed circuit board 
layout. The process of turning nets into tracks. 

scale To enlarge or reduce a printed circuit 
board representation when printing or plotting. 

schematic A graphical description of im 
electrical circuit. 

screen coordinates The X and Y 
coordinates reporting the location of the cursor 
on the screen. 

segment The partial track that exists between 
two adjacent vertices or between a vertex and a 
pin. (Sometimes the track between two pins is 
called a segment, although it is usually called a 
connection. ) 

signal An electrical impulse of a 
predetermined voltage, current, polarity, and 
pulse width. 

silkscreen Text or outlines (in ink) on the 
solder mask, on the top, and sometimes on the 
bottom of a board. Used for component 
identification and placement on a printed circuit 
board. 

SMD Acronym for surface mounted device. A 
component that is mounted on a surface layer of 
a printed circuit board, without penetrating the 
board. See also surface mount. 

SMT Acronym for surface mount technology. 
Printed circuit board technology in which the 
leads on the chips and components are soldered 
on top of the board as opposed to through it. The 
use of SMT results in smaller and faster printed 
circuit boards. 

solder mask A negative plot of pads with a 
guard band around the pads. Also, a lacquer 
applied to prevent solder from adhering to 
unwanted areas on the printed circuit board. 

solder-paste In Layout, a pattern that serves 
as a template for solder paste application when 
the board is manufactured. 
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solder side The printed circuit board surface 
opposite the one on which most components are 
mounted. Also, the bottom layer of the board. 

strategyfile A file that contains either 
placement or routing parameters for a specific 
type of board with a specific layer structure. 

surface mount A component mounting 
technology in which holes are not required for 
pins. 

technology template A file that contains 
placement and routing strategies, specifies the 
number of layers (including their names and 
properties), and specifies the various grids, 
number of defined vias, and padstacks for the 
board. 

test point A special point of access to an 
electrical circuit that is used for electrical testing 
purposes. 

thermal relief A means of connecting a pad to 
a larger copper area while minimizing the 
amount of copper available to conduct heat 
during the soldering process. 

thieving The process of balancing the amount 
of copper on both sides of a board so that 
through-hole plating is consistent from top to 
bottom during board fabrication. 

through-hole technology The process and 
components associated with producing a printed 
circuit board that employs traditional through­
hole components. . 

through-hole via A via that connects the 
surface layers on a printed circuit board. See also 
via. 

thrucode See padstack. 

tooling-hole . A tooling feature in the form of 
a hole in a printed board of fabrication panel. 

trace See track. 



track The copper trails in the printed circuit 
board and the onscreen representation of that 
copper. 

V-y 
venting patterns Patterns etched in the 
board that allow gases fonned during fabrication 
to escape. 

vertex A logical point at which a track is 
ended and restarted. A vertex is located at each 
change of direction on the track. 

via A hole connecting layers of a printed 
circuit board. A through-hole via connects 
surface layers of a board. On multilayer boards, a 
via not reaching a surface layer on one side is 
called a blind via, and a via not reaching a 
surface layer on either side is called a buried via. 

via stack An object that represents all of the 
via elements. A via stack definition. See also 
padstack. 

via stringer The copper etch that exists 
between an SMT pad and a corresponding fanout 
via. See also fanout. 

X axis The horizontal or left-to-right direction 
in a two-dimensional system of coordinates. 
(This axis is perpendicular to the Y axis.) 

V axis The vertical or bottom-to-top direction 
in a two-dimensional system of coordinates. 

z 
zero-length connection An unrouted 
connection between layers where the end points 
in the connection have the same X- and Y­
coordinates. In Layout, these connections are 
flagged with yellow triangles. 

zone An area on a printed circuit board layer 
designated as copper or anti-copper. Copper 
zones may have net names, while anti-copper 
zones may not. See also copper pour. 

Glossary 

zoom To change the view ofa window, 
making objects appear larger or smaller. When 
you zoom out, objects are smaller. When you 
zoom in, objects are larger. 
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A 
absolute dimension 199 
Add Color Rule dialog box 43 
Add Component dialog box 52,121 
Allow component editing on board command 27 
alternate footprints 119 
Alternate Layer command 144 
annotation 

back 232 
forward 227, 230 

anti-copper obstacle 74 
Apertures spreadsheet 32 
apertures, editing 214 
Arc command 82, 160 
arcs, creating 82, 160 
area selection 37 
arrow keys xi 
Assign Via per Net command 61 
Auto Pan 40 
Auto Path tool 27 
Auto Select 36,37,40 
AutoCAD 258-261 
autodimension 

absolute 199 
deleting objects and text 200 
relative 199 

Autodimension command 199 
Autodimension Options dialog box 199 
AutoECO 14 

options 227' 
resolving errors 17 

AutoECO command 227 
AutoECO/Add Only command 227 
AutoECOI Add Override command 227 
AutoECO/DXF command 227 
AutoECOlNet Attrs command 227 
AutoECOIOverride command 227 
autorouting, SmartRoute 8 

B 
back annotation 232 
BACKANNO.MAX file 232 
batch output, generating 212 
Board AutoCDE 167 
Board AutoDFM 168 
Board Design Check 163 
board files 270 

Board AutoCDE 167 
Board AutoDFM 168 
Board Design Check 163 
Board Space Check 166 
closing 21 
creating 47, 48 
opening 13-16 
saving 20 
translators 

CadS tar 252 
MAX Interchange 250 
MAXDXF 258-261 
PADS 253 
PCAD254 
PCB386+ 251 
ProteI 256 
Tango 257 

Window AutoCDE 167 
Window Design Check 165 
Window Space Check 166 

board outlines 9,13,48, 74 
creating 51 
editing 51 

Index 

verifying before component placement 92 
verifying before routing 124 

Board Space Check 166 
board templates 13, 48, 267 

creating custom 49 
selecting 13 

Browse Footprints dialog box 52,120 
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Index 

C 
CadStar translator 252 
Capture . 

creating a Layout-supported netlist in 224, 
226 

preparing your Capture design for use with 
Layout 224 

properties for use with Layout 224, 225 
Change Color command 138 
Change Via command 142 
Change Width command 141 
circular placement 112, 113 
Circular Placement dialog box 114 
closing 

board files 21 
designs 21 

Color spreadsheet 32,41 
color-coding nets 95 
colors 

adding objects and layers to Color 
spreadsheet 43 

deleting objects and layers from Color 
spreadsheet 43 

determining object and layer visibility 42 
editing 42 
Initialize Color command 28 
nets 62, 138 
setting for display 41 

commands 
Allow component editing on board 27 
Alternate Layer 144 
Arc 82,160 
Assign Via per Net 61 
Autodimension 199 
AutoEC0227 
AutoECOIAdd Only 227 
AutoECOIAdd Override 227 
AutoECOIDXF 227 
AutoECOlNet Attrs 227 
AutoECOIOverride 227 
Change Color 138 
Change Via 142 
Change Width 141 
Connection edit 146 
Database Spreadsheets 151 
Delete 29, 108 
Design Rules Check 27 
Disconnect Pin from Netlist 146 
DRCBox 127 
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Drill Chart Properties 207 
Drill Tape 216 
Enable<->Disable 102 
Exchange ends 81,144 
Exit 21 
Find 28 
Finish 51,73 
FixComps 98 
Force Width by Layer 141 
Grids 55 
Help 26 
Initialize Color 28,41 
Initialize Query 28, 33 
Insert 29, 108, 121, 140· 
Insert Via 141 
Library Manager 24, 27 
Load Strategy 101, 128 
Load Template File 48 
Lock Comps 98 
Lock Track 144 
Matrix Place 110 
Mincon 107 
Mirror 81,138 
ModifY 29,38,78,155,158,186,191,210 
Move Drill Chart 207, 208 
Move On/Off 108 
New 16,26 
Open 16, 26 
Opposite 81, 109 
Preview 153, 203 
Reconnect Enabled 27 
Refresh Copper Pour 28, 162 
Remove Center Partial 139 
Remove Partial Track 139 
Remove Track 139 
Remove Unlocked Track 139 
Restore original colors 209 
Ripup Conn 139 
Ripup Net 139 
Ripup Segment 139 
Rotate 80, 109 
Run Batch 212 
Save 20 
Save As 20 
Segment 81, 140 
Select Any 106 
Select Criteria 103 
Select Next 105 
Setup Batch 201 



Swap 108 
Tack Conn 143 
Text Editor 25 
Thennal Reliefs 150 
Undo 38 
Units 54 
Unlock Track 144 
User Preferences 39 
View whole board 28 
Zoom In 28 
Zoom Out 28,51 

Component Attachment dialog box 77 
component group keep-ins 75,100 
component group keep-outs 75,100 
component height keep-ins 40, 75,100 
component height keep-outs 40, 75,100 
Component Selection Criteria dialog box 103, 

106 
Component tool 27, 52 
component value, displaying on board 86 
components 

adding to design 121 
attaching text to 88 
editing 117. 
fixed 118 
group number 118 

. locked 118 
mirroring 109 
non-electric 118 
placing 91-122 
renaming 198 
rotating 109 
swapping 108 

Components spreadsheet 17,31 
computer-aided design (CAD), Visual CADD 9 
computer-aided manufacturing (CAM), 

GerbTool8 
Connection edit command 146 
connections, duplicate 137 
Control key xi 
coordinates (X,Y), viewing current 29 
copper area obstacles 74 
copper pour 157 

anti-copper 157 
attaching nets to 159 
clearance 76, 158 
copper area 157 
creating 158 
creating circular 160 

Edit Obstacle dialog box 158 
hatch pattern 76, 161 
isolate all routes 158 
obstacles 74 
reducing redraw time 40 
refreshing 162 
rules 76 
seed point 76, 157, 158 

copying 
components 108 
obstacles 79 
tracks 140 

Create New Footprint dialog box 182 
creating 

board designs 47-70 
board outlines 51 
custom footprint libraries 179 
custom templates 49 
DRCBox 127 
footprints 182 
nets 145 
obstacles 71, 72 
padstacks 59 

cross probing 233 
Capture to Layout 234 
Layout to Capture 235 

Curve Route tool 136 
custom footprint libraries, creating 179 
custom properties, displaying on board 87 

D 
Database Spreadsheets command 151 
Delete command 29, 108 
deleting components 108 
deselection 37 
design flow, Layout 3-5 
Design Rules Check command 27 
Design Rules dialog box 164 
design window 23 

opening the library manager 176 
designs 

Board AutoCDE 167 
Board AutoDFM 168 
Board Design Check 163 
Board Space Check 166 
closing 21 
creating 47, 48 
opening 13-16 
saving 20 

Index 
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Index 

Window AutoCDE 167 
Window Design Check 165 
Window Space Check 166 

detail grid 56 
detail obstacles 75 
dialog box 

Add Color Rule 43 
Add Component 52,121 
Autodimension 199 
Browse Footprints 52, 120 
Circular Placement 114 
Component Attachment 77 
Component Selection Criteria 103, 106 
Create New Footprint 182 
Design Rules 164 
Display Units 54 
Drill Chart Properties 207 
Edit Aperture 214 
Edit Color 42 
Edit Component 17, 117 
Edit Footprint 155, 186 
Edit Layer 53 
Edit Net 63, 95, 130 
Edit Obstacle 51,72,74,78,124,158 
Edit Pad 186, 190 
Edit Padstack 59,60,147,151,191,192 
Edit Padstack Layer 156, 191 
Edit Spacing 57, 58 
Enabling Layers for Routing 130 
Generate Reports 217, 232 
Hatchpattem 76, 161 
Layers Enabled for Routing 66 
Link Footprint to Component 17, 18 
Load Netlist source 16 
Load Strategy File 101, 128 
Load Template File 16, 48 
Modify Connections 146 
Net Spacing By Layer 70 
Net Widths By Layer 67 
Open Board 16 
Post Process Setup 210 
Reconnection Type 68 
Rename Direction 198 
Save MAX Board 16 
Select Criteria 104 
Select Data Window 151 
Select Footprint 119 
System Grids 55, 56, 60, 94 
Text Edit 85, 86 
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Thermal Reliefs 150 
User Preferences 39 
Zoom Layer 79, 80, 152 

dimensioning, in Layout 199 
disabling nets for routing 102, 132 
Disconnect Pin from Netlist command 146 
Display Units dialog box 54 
dot grid 56 
Dot Matrix printer, output to 202 
drafting, Visual CADD 9 
drawing, Visual CADD 9 
DRC see Design Rules Check command 
DRC Box command 127 
drill chart 

changing the size of 207 
moving 207, 208 

Drill Chart Properties command 207 
Drill Chart Properties dialog box 207 
Drill Chart spreadsheet 32, 207 
Drill Tape command 216 
drill tape, generating 216 
duplicate connections 137 
DXF 202,203 

import and export 258-261 

E 
Edit Aperture dialog box 214 
Edit Color dialog box 42 
Edit Component dialog box 17, 117 
Edit Footprint dialog box 155, 186 
Edit Layer dialog box 53 
Edit Net dialog box 63, 95, 130 
Edit Obstacle dialog box 51,72,74,78,124 

using to create a copper pour obstacle 158 
Edit Pad dialog box 186, 190 
Edit Padstack dialog box 59,60,147,151,191, 

192 
Edit Padstack Layer dialog box 156,191 
Edit Spacing dialog box 57, 58 
editing 

apertures 214 
board outlines 51 
colors 42 
components 117 
footprints 189 
net information 62,63 
objects 38 
obstacles 71, 78 
padstacks 191,192 



pins 189 
spreadsheet infonnation 32 

Enable<->Disable command 102 
enabling 

layers for routing 66 
nets for routing 130 

Enabling Layers for Routing dialog box 130 
Error Markers spreadsheet 31 
Error tool 27, 169 
errors, querying 169 
Escape key xi 
Exchange ends command 81, 144 
Exit command 

design window 21 
session frame 21 

exiting Layout 21 
exporting 237-261 

F 

board translators 247-261 
DXF 258-261 

fast fill copper pour 40 
files 

.LIS 275 
BACKANNO.MAX 232 
board (MAX) 13-16,270 
board template (TPL) 13-16,48,267 
custom templates 49 
Layout 265-275 
LAYOUT.INI 265 
LAYOUT. LOG 25, 275 
library 275 
LSESSION.INI 265 
MAX 270 
MNL270 
netlist (MNL) 13-16, 270 
stmtegy 271 
swap files 232 
SYSTEM.PRT 266 
TCH267 
technology template (TCH) 13-16, 48, 267, 

269 
TPL267 
USER.PRT 266 

Find command 28 
Finish command 51,73 
Fix Comps commands 

overriding 99 
setting 98 

footprint editor 24, 176 
creating new footprint in 182 

footprint libraries 173 
custom 179 
managing 175 

footprint name, displaying on board 87 
footprints 174 

adding pins to 183 
adding to libraries 180 
alternate 119 

Index 

assigning padstacks to footprint pins 185 
attaching obstacles to 187 
attaching text to 88, 89 
copying between libraries 180 
creating 182 
creating a custom libmry 179 
creating obstacles for 187 
deleting from libraries 180 
editing footprint pins 189 
labeling 188 
Link Footprint to Component dialog box 17, 

18 
missing 17 
selecting 120 
setting grids for 181 
viewing in the libmry manager 178 

Footprints spreadsheet31, 155 
Force Width by Layer command 141 
forced thennal reliefs 154, 155 
forward annotation 227,230 
free text, displaying on board 86 
free track obstacles 74 
Futurenet netlist 245 

G 
gates, checking before component placement 96 
Generate Reports dialog box 217, 232 
gerber 202,203 

GerbTool8 
preview 203 

GerbTool8 
OrCAD Layout for Windows GerbTool 

User's Guide 8 
GND 

enabling for routing 130 
routing 129 

on SMT boards 129 
on through-hole boards 129 

verifying connection to plane layer 131 
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Grid command 55 
griddless autorouting, SmartRoute 8 
Griddless Route tool 135 
grids 

detail 56 
dot 56 
options 56 
place 56 
routing 56 
setting 55, 56 
setting for footprint pins 181 
verifying routing grid before routing 125 
via 56 
viewing current setting in toolbar 29 

Group option 65 
groups, placing components in 106 

H 
hatch pattern 76, 161 
Hatch pattern dialog box 76, 161 
Help command 26 
help, online 30 . 
Highlight option 64 
highlighting nets 95 
Hole Legend see Drill Chart 
hollow pads 40 
HP Laser, output to 202 
HPGL output 202 . 

I 
importing 237-261 

board translators 247-261 
DXF 258-261 
netlist translators 238-246 

Initialize Color command 28,41 
Initialize Query command 28, 33 
Insert command 29, 108, 121, 140 
Insert Via command 141 
insertion origin 

centering 193 
moving 193 

insertion outlines 75 
verifying before component placement 92 

intertool communication· 
enabling in Capture 233 
enabling in Layout 233 
in design flow 3, 5 
using 233 
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invisible, making layers 42 
ITC see intertool communication 

K 
keep-ins 9, 75, 100 
keep-outs 9, 75,100 
keyboard keys xi 

L 
labeling components 85 
layers 

defining layer stack 53 
determining visibility 42 
drop list on toolbar 29 
editing 53 
enabling for routing 66 
library 94 
mapping 247 
mirror 94 
net spacing on 70 
placing text on 88 
preview for post processing 203 
setting net widths on 67 

Layers Enabled for Routing dialog box 66 
Layers spreadsheet 31,53,94 
layers, zoom 152 
Layout 

exiting 21 
features 6 
fIles used by 265-275 
product family 6 
session frame 11 
starting 11 

Layout Limited, features 6 
Layout Plus, features 6 
LAYOUT.INI fIle 265 
LAYOUT.LOG fIle 25, 275 
Learning Layout 30 
libraries 

adding footprints 180 
copying footprints to 180 
custom 173, 179 
deleting footprints from 180 
fIles 275 
library manager 173 
making available to Layout 177 
making unavailable to Layout 177 
managing 175 



library layers 94 
library manager 24,173,175-180 

creating a custom library 179 
footprint editor 176 
starting 176 
viewing footprints 178 

Library Manager command 24,27 
lines, setting preferences for 40 
Link Footprint to Component dialog box 17, 18 
Load Netlist Source dialog box 16 
Load Strategy command 101, 128 
Load Strategy File dialog box 101, 128 
Load Template File command 48 
Load Template File dialog box 16, 48 
loading 

placement strategy file 101 
routing strategy file 128 
technology template 48 

Lock Comps commands 
overriding 98 
setting 98 

Lock Track command 144 
locked components, overriding 98 
LSESSION.INI file 265 

M 
manual fanout ofSMDs 129, 131 
Manual Route tool 28, 133, 134 

determining behavior 39, 40, 134 
Manual Route with Shove tool 28 
manual routing 141 

changing layers during routing 144 
changing the widths of tracks 141 
changing via types 142 

. copying tracks 140 
creating duplicate connections 137 
Curve Route tool 136 
Exchange Ends command 144 
Gridded Manual Route without Shove tool 

133 
Gridless Route tool 135 
inserting via types 141 
locking tracks 144 
Mincon command 138 
mincon mode 40, 134 
moving segments on tracks 140 
Remove Center Partial command 139 
Remove Partial Track command 139 
Remove Track command 139 

Index 

Remove Unlocked Track command 139 
reroute mode 39 
Ripup Conn command 139 
Ripup Net command 139 
Ripup Segment command 139 
segment mode 40 
Tack Conn command 143 
vertex mode 39 

manufacturability 
ensuring 163 
GerbTool8 

mapping layers 247 
matrices, using 110, 111 
Matrix Place command 110 
MAX ASCII netlist 238 

example 240 
file format 239 

MAX files 270 
MAX Interchange 250 
Max Width option 65 
MAXDXF 258-261 
measurement, units of 54 
Min Width option 65 
Mincon command 107, 138 
mincon mode 40,134 
minimizing connections 107 
Mirror command 81 
mirror layers 94 
MNL files 270 

creating in Capture for use with Layout 224, 
226 

Modify command 29,38,78,155,158,186,191, 
210 

Modify Connections dialog box 146 
Modify/Create Nets tool 27, 145 
mounting holes 

adding to board 52 
disappearing during AutoECO 17 

Move Drill Chart command 207, 208 
Move On/Off command 108 
moving 

components 108 
DRCBox 127 
drill chart 207, 208 
obstacles 80 
obstacles to other layers 80 
text 89 
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N 
net attributes, setting 62, 63 
Net Spacing By Layer dialog box 70 
Net Widths By Layer dialog box 67 
netlists 13,226, 270 

nets 

contents 14 
part numbers do not match pad names in 

Layout 17 
preparing in Capture for use in Layout 224 
translators 

Futurenet 245 
MAX ASCII 238 
PCAD246 
PCB II 244 

adding test points 147 
assigning vias to 61 
attaching to copper pour 159 
attaching to obstacles 76 
changing the color of 138 
color-coding 95 
colors 62 
connection order 62 
creating 145 
disabling 102,130,131 
disconnecting pins from 146 
enabling 62, 130 
highlighting 95 
priority for routing 62 
properties in Capture for use with Layout 

225 
spacing by layer 70 
splitting 145 
verifying connection to plane layer 131 
weighting 95 
width by layer 67 
widths 62 

Nets spreadsheet 31,61,62,63,95,102,130 
New command 16, 26 
no via obstacles 75 
non-electrical components 17 

294 DreAD Layout for Windows User's Guide 

o 
Obstacle tool 27, 51, 72, 158 
obstacles 

anti-copper 74 
attaching nets to 76 
attaching to component 76 
attaching to footprint 187 
attaching to pin 76, 187 
board outlines 51, 74 
circular 82, 160 
component group keep-ins 75,100 
component group keep-outs 75, 100 
component height keep-ins 75, 100 
component height keep-outs 75, 100 
copper area 74 
copper pour 74 
copying 79 
copying to other layers 79 
creating 71, 72 
creating for footprints 187 
deleting 83 
detail 75 
Edit Obstacle dialog box 74 
editing 71,78 
exchanging the ends of 81 
free track 74 
insertion outline 75 
moving 80 
moving segments 81 
no via 75 
place outline 75 
reflecting 81 
rotating 80 
route keep-outs 75 
selecting 78 

Obstacles spreadsheet 31, 93 
online help 30 
online tutorial 30 
opaque graphics 40 
Open Board dialog box 16 
Open command 16, 26 
opening 

board files 13-16 
designs 13-16 

Opposite command 81, 109 
OrCAD Layout for Windows GerbTool User's 

Guide 8 
OrCAD Layout for Windows SmartRoute User's 

Guide 8 



OrCAD Layout for Windows Visual CADD 
User's Guide 9 

outlines 
board 51 
insertion 75 
place 75 

output 
batch 212 
specifying target device 202 

p 
package name, displaying on board 87 
Packages spreadsheet 31, 96 
pads 

hollow 40 
solid 40 

PADS translator 253 
padstacks 

assigning to footprint pins 185, 186 
changing the drill size 191 
creating 59 
editing 191,192 

Padstacks spreadsheet 59,147,151,156,191 
painting, setting preferences for 40 
parts, properties in Capture for use with Layout 

224 
PCAD 

board translator 246, 254 
netlist translator 246 

PCB II netlist 244 
PCB386+ translator 251 
Pin tool 27, 183, 186 
pins 

adding and deleting 146 
adding to footprints 183 
assigning padstacks to 185, 186 
attaching obstacles to 187 
checking before component placement 96 
disconnecting from nets 146 
editing 189 

Place Design Check 122 
place grid 56, 94 
place outlines 75 

verifying before component placement 92 
placing components 91-122 

description 4 
grid 56 
in a matrix 110 
in design flow 3 

in groups 106 
manually 101 
minimizing connections 107 
on a round board 112, 113 
one at a time 103, 104 
preparing the board for 92 

Index 

securing pre-placed components on board 98 
selecting the next component for placement 

105 
using circular placement 112, 113 

plane layers 149 
verifying connection of nets to plane layers 

131 
plotting 215 

specifying target device 202 
polar placement, using 112, 113 
pop-up menus 

accessing 35 
description 35 

Post Proc see Post Processing 
Post Process Setup dialog box 21 0 
Post Process spreadsheet 32,197,201 

previewing thermals using 153 
postprocessing 153, 197 

accessing commands 28 
adding and deleting files to output 213 
editing apertures 214 
in design flow 3, 5 
preview 203 

POWER 
enabling for routing 130 
routing 129 

on SMT boards 129 
on through-hole boards 129 

verifying connection to plane layer 131 
pre-placed components, securing on board 98 
preferences, setting user 39 

graphics 40 
lines 40 
manual route behavior 39 
object selection 40 
pads 40 
painting 40 
panning 40 
reducing redraw time for tracks 40 
reducing the redraw time for copper pour 40 
saving preference settings 40 
toolbar 40 

preferred thermal reliefs 154, 155 
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Preview command 153, 203 
preview, post processing 203 

modifying output 210 
restoring original view 209 

printing 215 
ProteI translator 256 

Q 
Query window 33 
Query, using with spreadsheets 34 
querying flagged errors 169 

R 
ratsnest 

description of 128 
zero-length connection 128 

Reconnect Enabled command 27 
Reconnection Type dialog box 68 
reference designator, displaying on board 86 
Refresh Copper Pour command 28, 162 
relative dimension 199 
Remove Center Partial command 139 
Remove Partial Track command 139 
Remove Track command 139 
Remove Unlocked Track command 139 
Rename Direction dialog box 198 
renaming components 198 
reports 

custom 217 
generating 217 

reroute mode 39, 40 
Restore original colors command 209 
Retry Enabled option 63 
Ripup Conn command 139 
Ripup Net command 139 
Ripup Segment command 139 
Rotate command 80, J09 
round board, placing components on 112, 113 
route keep-outs 75 
Route Spacing spreadsheet 57 
routing 123-148 

changing layers during routing 144 
changing the widths of tracks 141 
changing via types 142 
copying tracks 140 
creating duplicate connections 137 
description 4 
Exchange Ends command 144 
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forcing a net width on a layer 141 
grid 56,126 
in design flow 3 
insert via types 141 
locking tracks 144 
making vias available for 60 
manual 133-136 
Mincon command 138 
mincon mode 40, 134 
moving segments on tracks 140 
power and ground nets 129 

on a board with no plane layers 131 
on SMT boards 129 
on through-hole boards 129 

preparing the board 124 
Place Design Check 122 

process 123 
Remove Center Partial command 139 
Remove Partial Track command 139 
Remove Track command 139 
Remove Unlocked Track command 139 
reroute mode 39 
Ripup Conn command 139 
Ripup Net command 139 
Ripup Segment command 139 
segment mode 40 
statistics 148 
Tack Conn command 143 
unlQcking tracks 144 
using Curve Route tool 136 
using Gridded Manual Route without Shove 

tool 133 
using Gridless Route tool 135 
vertex mode 39 

Routing Enabled option 63 
routing grid 56 
Run Batch command 212 
Run ECO to Layout 231 

S 
Save As command 20 
Save command 20 
Save MAX Board dialog box 16 
saving 

board files 20 
designs 20 

schematics 4 
netlists 13 



part numbers do not match pad names in 
Layout 17 

preparing in Capture for use with Layout 
224 

seed point, designating for copper pour 157 
Segment command 81,140 
segment mode 40 
segments, moving 81 
Select Any command 106 
Select Criteria command 103 
Select Criteria dialog box 104 
Select Data Window dialog box 151 
Select Footprint dialog box 119 
Select Next command 105 
selecting 36-37 

area 37 
deselecting 37 
in tool mode 36, 37 
mUltiple objects 37 
obstacles 78 
one object 37 
using Auto Select 36, 37, 40 

session frame 8, 11 
opening the library manager 176 

session log 25 
setting up the board 47-70 

process 47 
technology templates 48 

Setup Batch command 201 
Share Enabled option 64 
Shove Enabled option 64 
SmartRoute 8 

OrCAD Layout for Windows SmartRoute 
User's Guide 8 

solid pads 40 
spacing 57 

nets 70 
pad to pad 58 
track to pad 58 
track to track 58 
track to via 58 
via to pad 58 
via to via 58 

splitting nets 145 
spreadsheets 

accessing 28 
Apertures 32 
Color 32,41 
Components 17, 31 

descriptions 31 
Drill chart 32 
editing 32 
Error Markers 31 
Footprints 31, 155 
Layers 31, 53, 94 
list of 31 
Nets 31,61,62,63,95,102,130 
Obstacles 31, 93 
Packages 31, 96 
Padstacks 59,147,151,156,191 
Post Process 32, 197, 201 

previewing thermals using 153 
Route Spacing 57 
Statistics 31, 122, 148 
Strategy 32 
Text 31 
using Query with 34 

starting 
Layout 11 
library manager 176 

statistics 
placement 122 
routing 148 

Statistics spreadsheet 31,122,148 
status bar 30 
strategy files 271 

description 272 
list of 272 
loading 101, 128 
placement 101 
PLSTD.SF 101 

Strategy spreadsheets 32 
subnets 154 
Swap command 108 
System Grids dialog box 55, 56, 60,94 
SYSTEM.PRT files 266 

T 
Tack Conn command 143 
Tango translator 257 
technology templates 267, 269 

IBET_ANY.TCH 13 
DEFAULT.TCH 13, 48 
description 269 
list of 269 
loading 48 

templates 
board 13, 48, 267 

Index 
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creating custom 49 
technology 13, 48, 267, 269 

Test Point option 64 
test points 

text 
generating interactively 147 

as used in this manual xii 
character aspect 88 
character rotation 88 
Component Value 86 
creating 85 
Custom Properties 87 
deleting 89 
editing 85 
Footprint Name 87 
Free 86 
labeling footprints 188 
location 88 
mirrored 88 
moving 89 
Package Name 87 
radius 88 
Reference Designator 86 
rotation 88 
size 88 
strings 86 
Text Edit dialog box 86 
width of text line 88 

Text Edit dialog box 85, 86 
Text Editor command 25 
text editors 25 
Text spreadsheet 31 
Text tool 27, 85, 89 
thermalreliefs 129, 149-156 

creating 149 
defining 150 
forced 154, 155 
large, assigning 151 
pads 149 
preferred 154, 155 
previewing 152-153 
rules that apply to creating 154 
using padstacks to create" 156 

Thermal Reliefs command 150 
Thermal Reliefs dialog box 150 
toolbars 

design window 
Allow component editing on board 

command 27 
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Auto Path tool 27 
Component tool 27 
Delete command 29 
Design Rules Check command 27 
Error tool 27 
Find command 28 
Initialize Color command 28,41 
Initialize Query command 28 
Insert command 29 
layer drop list 29 
Library Manager command 27 
Manual Route tool 28 
Manual Route with Shove tool 28 
Modify command 29 
Modify/Create Nets tool 27 
Obstacle tool 27 
Pin tool 27 
Post Processing 28, 153 
postage stamp viewer 29 
Reconnect Enabled command 27 
Refresh Copper Pour command 28 
Spreadsheets 28, 53 
Text tool 27 
View whole board command 28 
viewing grid setting 29 
viewing object coordinates 29 
Zoom In command 28 
Zoom Out command 28 

enabling or disabling tooltips 40 
session frame 

Help command 26 
New command 26 
Open command 26 

setting preferences for 39 
tools 

Auto Path 27 
Component 27, 52 
Curve Route 136 
Error 27,169 
Griddless Route 135 
Manual Route 28, 133, 134 
Manual Route with Shove 28 
Modify/Create Nets 27, 145 
Obstacle 27,51, 72, 158 
Pin 27,183,186 
Text 27, 85, 89 

tooltips 40 
tracks 

copying 140 



reducing redraw time 40 
routing manually 133-136 

translators 
board 247 

CadStar 252 
MAX Interchange 250 
MAXDXF 258-261 
PADS 253 
PCAD254 
PCB386+ 251 
Protei 256 
Tango 257 

netlist 
Futurenet 245 
MAX ASCII 238 
PCAD246 
PCB II 244 

tutorial, Layout online 30 

u 
Undo command 38 
undoing actions 38 
Units command 54 
units of measurement 54 
Unlock Track command 144 
Use all via types option 60 
User Preferences command 39 
User Preferences dialog box 39 
USER.PRT files 266 

v 
vertex mode 39, 40 
via grid 56 
vias 154 

assigning to nets 61 
making available for routing 60 
verifYing before routing 125 

View whole board cor:nmand 28 
visible, making layers 42 
Visual CADD 258 

w 
OrCAD Layout for Windows Visual CADD 

User's Guide 9 

Weight option 65 
weighting nets 95 
widths of nets 67 

Window AutoCDE 167 
Window Design Check 165 
Window Space Check 166 
windows 

y 

design 23 
footprint editor 24 
library manager 24 
Query 33 
session log 25 
setting preferences for 40 
spreadsheets 31 

yellow triangles in ratsnest 128 

z 
Zoom In command 28 
Zoom Layer dialog box 79, 80, 152 
Zoom Out command 28,51 
zoom, layers 152 

Index 

OrCAD Layout for Windows User's Guide 299 







MN-Ol-S044 CDS 7.SK 10/97 Recyclable * 


